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Welcome to Wimba Pronto  

 
  

Wimba Pronto is an academic-centric instant collaboration solution designed to promote learning through group 

work and academic and administrative help. One of the main differences between Wimba Pronto and other 

collaboration solutions is that Wimba Pronto synchronizes with your institution's enrollment records. This means 

that students and teachers are automatically connected with other Wimba Pronto users enrolled in the same 

courses. The full version of Wimba Pronto also includes advanced features such as video chat, application sharing, 

and a robust whiteboard, which allow everyone at your institution to collaborate and communicate quickly and 

easily. 

  

This guide will take you through all of the features of Wimba Pronto. 

If you don't already have Wimba Pronto, follow the instructions here to get it right now. 

Top Wimba Pronto Features 

These are some of the most helpful features of Wimba Pronto (included in Wimba Pronto Basic): 

 

 Text Chat for communicating quickly and efficiently with your classmates 

 Audio Calling for simple, hands-free voice chat 

 Group Chat for collaborating with your friends, partners, or classmates 



 
 
 

    
    
                                                                                                                                                                                                                                                                      2 
 

In addition, the full version of Wimba Pronto has the following powerful features: 

 

 Video Calling for face-to-face contact and more natural communication within either one-on-

one conversations or group collaborations 

 Application Sharing for real-time display of any document or application on your computer 

 Whiteboard for interaction with integrated learning objects and background templates to 

harness the power of visual instruction 

 Office Hours to create a focused setting where classmates and contacts can queue up for 

individual attention 

 Help Desks for virtual assistance from the administrative services at your institution 
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What's New in Wimba Pronto? 

 If you've used Wimba Pronto in the past, but are curious about what's new, the list below includes the most recent 

changes so that you can get up and running quickly with all of the latest features. 

Wimba Pronto 3.1 

  

• If your computer supports your camera, so does Wimba Pronto. Support for any video device that your 

computer supports. 

• Proxy Support so you can use Wimba Pronto through a proxy network. 

• Invitations to make activating a Wimba Pronto account easier and faster than ever. 

Wimba Pronto 3.0 

  

• Whiteboard for advanced, next-generation collaboration 

• Queued Chat is now called Office Hours 

  

See Also: 
About Invitations 

About Whiteboard 

About Office Hours 
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Getting Started 

Wimba Pronto System Requirements 

The minimum system requirements for Wimba Pronto are as follows: 

• Windows XP+ or Mac OS 10.4+  

• 128 MB RAM (256 MB recommended)  

•  An Internet connection at 56 kbps or higher  

•  Sound Card (for Audio Calling)  

•  Speakers and Microphone for Audio Calling (USB headset with integrated microphone recommended)  
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Creating a New Wimba Pronto Account 

Use one of these three methods to create a Wimba Pronto account. 

  

1. Through a Course Management System: Navigate to a Wimba Pronto link in your institution's Course 

Management System (CMS) (for complete instructions, refer to Locating a Wimba Pronto Link in Your CMS) 

2. By Invitation: Follow the instructions and click the link in an email invitation from Wimba, your institution, 

or another Wimba Pronto user (such as an instructor or classmate). 

3. With a Registration Code: Go to the Wimba Pronto Registration page here and enter a unique registration 

code from your institution along with your last name (surname) as it appears in your institution's systems. 

  

Each of these methods will open the Wimba Pronto registration form. Follow the steps below to fill out the form. 

  

 

https://pronto.wimba.com/user/register�
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To Create a Wimba Pronto Account 

1. Create your Pronto ID: In Wimba Pronto, you are identified by your full name, as it appears in your 

institution's systems. Your  Pronto ID is used for logging in, managing your account, and allowing users 

who are not in your classes to contact you. This ID is unique and does not need to match your institution's 

systems. If you are associated with two or more institutions that use Wimba Pronto, you can use the same 

Pronto ID for both (refer to Linking Accounts for instructions). 

2. Email: Each Pronto ID must be associated with a unique email address. If you cannot or do not wish to link 

your accounts from two different institutions, you will need to use a different email address for each 

account. 

3. Password: Enter a password that is memorable but difficult to guess. 

4. Security Question: Choose a security question from the list. In the event that you cannot remember your 

password, this question will be used for password recovery. 

 
5. Once you have created your Pronto ID, you can install Wimba Pronto on your computer. For complete 

details refer to Downloading and Installing Wimba Pronto . 
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Locating a Wimba Pronto Link in Your CMS 

Wimba Pronto synchronizes with course enrollments at your institution, so you can access the Wimba Pronto 

registration page via a Pronto link in your CMS. 

To Locate a Wimba Pronto Link in Your CMS 

1. Log in to your Course Management System. 

2. Navigate to any Wimba Pronto link. This step varies slightly between CMS systems. 

• If you are using Blackboard Enterprise or Learn, the Pronto link may be located in the 

Communication Area, the Tools Area, or on the My Institution page. 
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• If you are using Blackboard Vista/Campus Edition, the Pronto link may be located in the External 

Courses area of the My Blackboard (or My WebCT) page, or within a Section. 

 

 
 

• If you are using Moodle, the Wimba Pronto link can either be an activity within a course, or an 

image within a Block. 

 

 
 

3. The Wimba Pronto registration form opens. If you have already created a Pronto ID account, the Wimba 

Pronto Settings page appears. 

For more information on registering for Wimba Pronto, refer to Creating a New Wimba Pronto Account and follow 

the instructions there. 
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Linking Accounts 

If you change institutions and want to continue using your existing Wimba Pronto account, you can link it to your 

new institution. As long as you are still active on your previous institution's server, you can also access a list of your 

classmates for both institutions simultaneously.  

To Link an Existing Wimba Pronto Account to a New Institution 

1. Use any of the three methods detailed in Creating a New Wimba Pronto Account. 

2. Click any Wimba Pronto link. The Wimba Pronto registration page appears. 

 

 

 

3. Click the I already have a Wimba Pronto account link. The Link Your Wimba Pronto Account page opens. 

4. Log in using your existing Wimba Pronto account information. Your new account is linked to your Wimba 

Pronto account and the Wimba Pronto Settings page opens. 

  

Note: 
If your institution is Walled In, you will not be able to link your accounts unless you are an administrator or 

instructor. Students at Walled In institutions can communicate only within a single institution. As an alternative, 

you can create a second Pronto ID with a different email address at your second institution. 
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Downloading and Installing Wimba Pronto 

You can download and install the Wimba Pronto client after creating your Wimba Pronto account. You can perform 

this step either immediately after activating your account, or at a later time. 

To Download and Install Wimba Pronto for Windows 

1. Log in to the Wimba Pronto Settings page using your Pronto ID and password. 

• If you just created your account, you may already be logged in to the Wimba Pronto Settings page. 

• If you did not just create your account, or you need to download and install Wimba Pronto again, go to 

http://pronto.wimba.com and sign in using your Pronto ID and password. 

2. Click the Download Wimba Pronto for Windows graphic. The Wimba Pronto installer downloads to your 

hard drive. 

3. Double-click the ProntoSetup icon on your desktop. The Pronto Setup launches. 

4. Select a default language for the Wimba Pronto client. 

5. Click OK. 

6. Click Next >. 

7. Review the license agreement and click I Agree. 

8. Select whether you wish to install Desktop and QuickLaunch Shortcuts. 

9. Click Next >. 

10. Select where you wish to install Wimba Pronto. 

11. Click Install. Wimba Pronto installs and a confirmation screen opens. 

12. Select whether you wish to run the program right away. 

13. Click Finish. 

  

Note: 
Regardless of which language you select during installation, Wimba Pronto is installed in both English and 

Spanish. You can change your language setting at any time from the Preferences window.  

http://pronto.wimba.com/�
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To Download and Install Wimba Pronto for Mac 

1. Log in to the Wimba Pronto Settings page using your Pronto ID and password. 

• If you just created your account, you may already be logged in to the Wimba Pronto Settings page. 

• If you did not just create your account, or you need to download and install Wimba Pronto again, 

go to http://pronto.wimba.com and sign in using your Pronto ID and password. 

2. Click the Download Wimba Pronto for Mac OS X graphic. The Wimba Pronto installer is downloaded to 

your hard drive and the Pronto End User License Agreement opens. 

3. Review the license agreement and click Agree. The Pronto disk image opens.  

4. Drag the Pronto icon to your Applications folder. 

  

Tip: 
You can install Wimba Pronto on as many computers as you wish, making it easy to keep in touch with friends 

and classmates, even if you are not at your primary computer. 

  

See Also: 
Language Settings 

Creating a New Wimba Pronto Account 

Accessing the Wimba Pronto Settings Page 

http://pronto.wimba.com/�
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Logging In 

You log in to the Wimba Pronto client using the Pronto ID and password that you chose when creating your 

account. Whenever you launch Wimba Pronto, the login window appears. 

To Log in to Wimba Pronto 

  

 
  

1. Enter your Pronto ID. 

2. Enter your password. 

3. Click the sign in button.  

  

Tips: 

a) You can set Wimba Pronto to remember your Pronto ID and password by checking the remember me box. If 

you do this, anyone with access to your computer can access your Wimba Pronto account.  

b) You can also set Wimba Pronto to automatically sign you in when you launch the program by checking the 

sign in automatically box. This setting can be changed in the Preferences window. 

  

See Also: 

Creating a New Wimba Pronto Account 
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Interface Overview 

About the Wimba Pronto Interface 

Wimba Pronto is based around the Wimba Pronto window, from which you manage communication with other 

users and access the program's more advanced features. The five main elements of the Wimba Pronto window are: 

the Contacts tab, the Classmates tab, the School tab, the Status Bar, and the Menu Bar. 

  

 
  

Note: 

On Mac OS X, the Menu Bar is located at the top of the screen, rather than within the Wimba Pronto window. 

See Also: 
Adding a New Contact to Your Contacts Tab 

Changing Your Status 
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The Contacts Tab 

 
  

The Contacts tab is where you keep track of your friends, study groups, and anyone else that you contact often. This 

tab is initially empty, but you can add any Wimba Pronto user, as long as you know his or her Pronto ID; the user 

does not need to be in one of your classes, or even at your institution. The Find field allows you to search for a 

specific user in the list. You can also add groups to keep your contacts organized. 
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The Classmates Tab 

 
  

The Classmates tab lists all of the Wimba Pronto users who are in your classes. If the instructor of a course has a 

Wimba Pronto account, the label (Instructor) appears next to his or her name. You do not need to add users to 

your Classmates tab; it is automatically populated based on course enrollments within your institution's system. 

You also cannot manually add or delete classmates. The Find field allows you to search for users in the list. 

  

Tip: 

Classmates appear only while you are enrolled in a class. However, users remain in your Contacts tab indefinitely, 

so make sure you add classmates with whom you want to keep in touch as contacts before the semester ends. 
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The School Tab 

 
  

The School tab lists the Help Desks that your institution has set up. These may include campus offices, library 

services, academic counseling, or any other resource that your institution wants to make easily available. A number 

appears in the tab label when Help Desks are available. Open Help Desks display the Office Hours icon  next to 

their name, while closed Help Desks display the offline icon . Help Desks can only be added, deleted, or modified 

by your institution's Wimba Pronto Administrator. The Find field allows you to search the list for a specific Help 

Desk. 

  

Note: 

The School tab only appears if your institution has set up at least one Help Desk. 
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The Status Bar 

 
  

The Status Bar shows your current availability. Since other Wimba Pronto users see this status, you can use it to tell 

other people what you are doing and if it is a good time to contact you. Status messages are fully customizable and 

can be saved for future use. 

The Menu Bar 

 
  

The Menu Bar provides access to nearly every feature in Wimba Pronto. While many of the commands can be 

accessed from other places in the program, the Menu Bar provides quick, convenient access to commonly used 

features. The Menu Bar is also where you can access the Preferences window, modify display options, and exit the 

program. 
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Managing Your Accounts and Contacts 

About Wimba Pronto Accounts and Contacts 

One of the unique features of Wimba Pronto is that it automatically populates your Classmates tab, allowing you to 

communicate with other Wimba Pronto users in your classes without having to know their Pronto IDs. You can 

quickly see how many people from each of your classes use Wimba Pronto, and who is currently online. You can still 

keep a personalized list of users by using the Contacts tab, which allows you to add Wimba Pronto users, regardless 

of whether or not they are in your classes.  
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Adding a New Contact to Your Contacts Tab 

The Contacts tab is where you keep track of your friends, classmates, instructors, and anyone else that you want to 

be able to easily contact. You can add any Wimba Pronto user to your contacts, even if they are not in one of your 

classes or enrolled at your institution. 

  

To add a classmate to your Contacts tab, click the plus icon  next to the user's name in the Classmates tab. The 

smiley icon  indicates that the user has been added to your Contacts tab. 

  

 

To Add a User to Your Contacts Tab by Pronto ID 

1. Click the Actions menu. 

2. Select Add Contact... The Add Contact window opens. 

3. Type the Pronto ID of the user you wish to add. 

4. Select the group within your Contacts tab to which you wish to add the person. 

5. Click Add. The user is added to your Contacts tab. 

  

Note: 
You can use the Pronto ID method to add any Wimba Pronto user to your Contacts tab, even if they are in your 

Classmates tab. However, clicking the plus icon is the faster way to add classmates. 

Tip: 

If a user who is not in your Contacts or Classmates tab contacts you, a notification appears above the message 

giving you the option to add the user to your Contacts tab or to block the user.  

  

See Also: 
Adding a New Group to Your Contacts Tab 

Adding a Contact To a Group 

Removing a User From Your Contacts Tab or From a Group 
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Adding a New Group to Your Contacts Tab 

You can organize users in your Contacts tab by groups. For example, you could create a group for your study 

partners, or for your friends from high school. When you start Wimba Pronto for the first time, the Contacts tab is 

empty. When you add a new contact, unless you specify otherwise in the Add Contact window, the user is 

automatically added to a default group called Recently Added. You can create as many groups as you wish to keep 

your contacts organized. 

To Create a New Group 

1. Click the Actions menu. 

2. Select Add Group... The Add Group window opens. 

3. Type the name of the group you wish to create. 

4. Click Add. The group is created and added to your Contacts tab. 

  

See Also: 

Adding a New Contact to Your Contacts Tab 

Adding a Contact To a Group 
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Adding a Contact to a Group 

Once you have created groups in your Contacts tab, the next step is to add contacts to these groups. There are a 

couple of different ways to add a contact to a group, depending on whether or not you have already added the 

user to your Contacts tab. 

  

To add a user that is already in your Contacts tab to a group, simply drag and drop his or her name to the name of 

the group. 

 

 

To Add a User Not Already in Your Contacts Tab to a Group 

1. Click the Actions menu. 

2. Select Add Contact. The Add Contact window opens. 

 

 
 

3. Type the Pronto ID of the person you wish to add. 

4. Select the group to which you wish to add the person. 

5. Click Add. The user is added to the selected group within your Contacts tab. 

  

See Also: 
Adding a New Contact to Your Contacts Tab 

Adding a New Group to Your Contacts Tab 

Removing a User From Your Contacts Tab or From a Group 
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Removing a User from Your Contacts Tab or a Group 

The process for removing a user from your Contacts tab is the same as removing a user from a group; if you remove 

a user from a group, he or she is also removed from the Contacts tab (unless the person is in more than one group). 

There two different ways to accomplish this. 

To Remove a Contact Using the Contacts Tab 

1. Click the Contacts tab, if it is not already selected. 

2. Right-click (Ctrl-click on Mac) the name of the contact that you wish to remove. 

3. Select Remove <User Name>. The Remove <User Name> window opens. 

4. Click OK. The user is removed from both the Contacts tab and the group. 

To Remove a Contact Using the Actions Menu 

1. Click the Contacts tab, if it is not already selected. 

2. Click the name of the contact that you wish to remove. 

3. Click the Actions Menu. 

4. Select Remove <User Name>. The Remove <User Name> window opens. 

5. Click OK. The user is removed from both the Contacts tab and the group. 

  

Note: 

If you remove a contact that is in one of your courses, he or she will still be listed in your Classmates tab. Since the 

Classmates tab is automatically populated from your institution's enrollments, you cannot manually add or 

remove classmates. 

See Also: 
Adding a New Contact to Your Contacts Tab 

Adding a Contact To a Group 
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Changing Your Status 

The Status Bar displays your current availability. Other Wimba Pronto users see this status, so you can use it to tell 

other people what you are doing, and if it is a good time to contact you. You can change your status to one of the 

default options, or create a new custom status.  

  

The default status options are:  

  

• Available  

The Available status lets other users know that you are free and that it's a good time to contact you. 

• Away  

The Away status lets other users know that you are busy and that it may not be a good time to contact you. 

You may wish to create a custom away status to let other people know what you're doing or when you'll be 

back. 

• Office Hours  

The Office Hours status is unique because selecting accesses a Wimba Pronto feature, instead of just 

displaying a status message. When you set your status to Office Hours, a new Office Hours session is started 

with you as the host.  

• Invisible  

The Invisible status is a way of hiding yourself from other users while still remaining online. When you set 

your status to invisible, you appear to others users as if you were offline, but you can still communicate with 

other users normally. If your status is set to Invisible and another user tries to send you message, you will 

receive the message. 

• Offline   

The Offline status is the same as logging out of your Wimba Pronto Account; when you are offline, you 

cannot contact other users and other users cannot contact you. If you are offline, and another user tries to 

send you a message, you will not receive the message. 
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To Change Your Status  

1. Click the Status Bar. 

 

 
 

 

2. Select the desired status. Your new status is set. 

See Also: 

Creating a New Custom Status 

About Office Hours 
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Creating a New Custom Status 

If you do not want to use the default status messages, or you prefer to display a more specific message, you can 

create a custom status. While the most common use of custom statuses is creating custom away messages, you can 

also create a custom available status. Custom statuses can be saved for future use.  

To Create a New Custom Status 

1. Click the Status Bar. 

2. Select Custom... under Available, Away, or Office Hours. The Edit Custom Status window opens. 

 

 
 

3. Type a name for the status in the Title field. This title is for your own reference only and is not seen by other 

users. 

4. Type the status in the Message field. This is the text that is displayed to other users. 

5. If you wish to be able to reuse this status in the future, check the Save for future use box. 

6. If you want other users to automatically receive a reply message with your status when enabled, check the 

Auto-reply box. 

7. Click OK. The custom status is created and is set as your current status. 

  

Tip:  

If you want the Title and the Message of the Status to be the same, you can simply type the text in the Message 

field; the Title field is filled in automatically. 

  

See Also: 

Changing Your Status 
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Modifying Your Profile 

You can create a personalized profile with a picture to share information about yourself with other Wimba Pronto 

users. Adding a picture, or other information, is optional. You can add or modify profile information from the Profile 

section of the Preferences window.  

  

To access the Profile editor, click your profile picture box to the left of the Status Bar in the Wimba Pronto window. 

  

 

Profile Picture 

You can add a profile picture that is visible to other Wimba Pronto users to add a personal touch to your profile. 

Your picture is visible any time you contact another Wimba Pronto user, anytime another user contacts you, when a 

user views your profile, or when a user hovers his or her cursor over your name in the Contacts or Classmates tab. 

To add a profile picture, either drag an image file from your hard drive to the Drag Image Here box, or click the 

Choose Picture... button and browse your hard drive for the desired picture. The profile picture box is optimized 

for square images, but accepts images of any proportions.  

Email 

You can add an email address to make it easier for other users to contact you when you're not on signed in to 

Wimba Pronto. This address does not need to be your school email address or the address associated with your 

Wimba Pronto account. 
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About Me 

The About Me box allows you to type a brief description to introduce yourself to other users. You may wish to 

include your interests, your major, where you're from, or the type of people with whom you would like to 

communicate using Wimba Pronto.  

My Webpages 

The My Webpages box allows you to include links in your profile to the websites of your choice. You may wish to 

add personal, course, or department webpages. 

  

See Also: 

Profile Preferences 
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Changing Your Display Settings 

You can control the way in which users are displayed in the Wimba Pronto window by using the View menu. These 

display settings apply to both the Contacts and the Classmates tabs.  

  

 

Show Offline Contacts 

Toggles the display of users that are not currently logged in to Wimba Pronto 

Show Blocked Contacts 

Toggles the display of users that you have blocked 

Show Classmates Without Pronto 

Toggles the display of classmates that are not currently registered for Wimba Pronto; this option only appears if 

Invitations are enabled at your institution  
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Sort Contacts by First Name 

Displays users organized alphabetically by first name 

Sort Contacts by Last Name 

Displays users organized alphabetically by last name 

Sort Contacts by Availability 

Displays users that are available first, followed by users that are away, users that are idle, and users that are offline 

Show Group Counts 

Toggles the display of user counts for each group or course 

Collapse All Groups 

Hides the user list for all groups, showing only the group name. You can collapse or expand individual groups by 

clicking the arrow next to the group name. 

Expand All Groups 

Reveals the user list for all groups. You can collapse or expand individual groups by clicking the arrow next to the 

group name. 

Show Status Messages 

Toggles the display of users' custom status messages under their names in the Wimba Pronto window. If this option 

is disabled, you can view a user's status by hovering your mouse over his or her name. 

  

See Also: 

Blocking and Unblocking Users 
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Blocking and Unblocking Users 

By default, all Wimba Pronto users can freely communicate with each other, regardless of whether or not they are in 

same classes, or even at the same institution. However, if there are users that you do not want to be able to contact 

you, you can block them. Blocked users cannot contact you, and you cannot contact them. If the user is in either 

your Contacts or Classmates tab, you can still see his or her status, but you always appear as offline to the blocked 

user. Users never know that they have been blocked, and you can unblock users at any time.  

  

You can block or unblock a user from either the Wimba Pronto window or the Preferences window. Also, if 

someone not in your Contacts or Classmates tab contacts you, you are given the option of blocking the user. 

To Block a User from the Wimba Pronto Window 

1. Right-click (Ctrl-click on Mac) the name of the user that you wish to block in either the Classmates or 

Contacts tab. 

2. Select Block <User Name> from the pop-up menu. The Block Contact window opens. 

3. Click Yes. The name appears with a strikethrough to indicate that the user has been blocked. 

 

Note: 
If the user is already blocked, the Block <User Name> option changes to Unblock <User Name>; you can use 

this option to unblock the selected user. 

Tip: 
If you do not want blocked users to appear in your Contacts and Classmates tabs, disable Show Blocked 

Contacts in the View menu. 
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To Manage Blocked Users from The Preferences Menu 

1. Click the Pronto menu. 

2. Select Preferences... The Preferences window opens. 

3. Select Privacy. 

4. Add or remove users from your Block List as desired: 

• To add a user to your Block List, click the plus button , type the user's Pronto ID, and click Add. 

• To remove a user from you Block List, select the user from the list and click the minus button . 

5. When you have finished modifying the Block List, click OK. 

  

Tip: 

Since the Block List allows you to block users by their Pronto IDs, you can use this method to block any Wimba 

Pronto user— even if he or she is not in any of your classes. 

See Also: 

Privacy Preferences 

Changing Your Display Settings 
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Viewing a User's Profile 

Any Wimba Pronto user can create a Profile to share with friends, classmates, and instructors. You can use Profiles 

to find out more information about a user, or to find a user's contact information (if he or she has shared it).  

  

You can see a partial profile by hovering your cursor over a user's name in your Contacts or Classmates tab. This 

view shows you the user's picture, current status, and About Me description; it does not show email addresses or 

webpages. 

To View a User's Profile 

1. Click the name of the desired user in either your Contacts or Classmates tab. 

2. Click the Actions menu. 

3. Select Show Profile Info. A new Text Chat window opens with the user's profile displayed. 

  

 
  

See Also: 

Modifying Your Profile 
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Accessing the Wimba Pronto Settings Page 

The Wimba Pronto Settings page is a web portal that allows you to view and manage your account settings and 

login information, as well as determine which of your courses appear in Wimba Pronto. You can access the Wimba 

Pronto Settings page either from a link within Wimba Pronto, or directly using your web browser. 

To Access the Wimba Pronto Settings Page from Wimba Pronto 

1. Click the Pronto menu. 

2. Select Account Settings. The Wimba Pronto Settings login page opens in your web browser. 

 

 

3. Type your Pronto ID. 

4. Type your Pronto Password. 

5. Click the Sign In button. 
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To Access the Wimba Pronto Settings Page from a Web Browser 

1. Go to the URL: http://pronto.wimba.com/ 

2. Type your Pronto ID. 

3. Type your Pronto password. 

4. Click the Sign In button. 

  

Tip: 

You can also access the Wimba Pronto Settings page, without logging in again, from your CMS. If you forget your 

password and security question, this is the best way to access your Wimba Pronto account.  

  

See Also: 
Modifying Your Account Settings 

Modifying Your Course Settings 

http://pronto.wimba.com/�
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Modifying Your Account Settings 

From the Wimba Pronto Settings page, you can view and modify your account settings including your password, 

the email address associated with your account, and your security question. 

  

 

To Change Your Password 

1. On the Wimba Pronto Settings page, click the change password... link. The Change Password window 

opens. 

2. Type your current password in the Current password field. 

3. Type your desired password in the New password field. 

4. Re-type your desire password in the Confirm new password field. 

5. Click the Save button. The Password changed confirmation page opens, indicating that your new password 

has been successfully updated.  

To Change the Email Address Associated with Your Wimba Pronto Account 

1. On the Wimba Pronto Settings page, click the change email... link. The Change Email window opens. 

2. Type your Pronto password in the Current password field. 

3. Type the email address that you would like associated with your Wimba Pronto account in the New Email 

field. 

4. Re-type the desired email address in the Confirm New Email field. 

5. Click the Save button. The Email changed confirmation page opens, indicating that your new email address 

has been set successfully. 

  

Note: 

The email address associated with your Wimba Pronto account does not have to be a school email address or the 

email address associated with your CMS account. 
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To Change Your Security Question 

1. On the Wimba Pronto Settings page, click the change security question... link. The Change Security 

Question window opens. 

2. Select a Security Question from the drop-down menu. 

3. Type your response in the Answer field. 

4. Click the Save button. The Security Question changed page opens, indicating that your security question 

has been successfully updated.  

To Change the Language Setting for Your Wimba Pronto Account 

1. On the Wimba Pronto Settings Page, click the Language drop-down menu. 

2. Select the desired language. 

To Delete Your Wimba Pronto Account  

1. On the Wimba Pronto Settings page, click the Support link. The Wimba Pronto Support page opens. 

2. Click the Delete Your Account link. The Delete Your Account page opens. 

3. Select a reason for deleting your Pronto Account from the drop-down menu. 

4. Add any additional comments in the Comments box. 

5. Click the Continue button. The Confirm Delete page opens. 

6. Type your Pronto password in the Password field. 

7. Click the Delete this account button. Your account is deleted. 

  

Note: 

Reasons for deleting your Wimba Pronto account include if you are unhappy with your Pronto ID or if you 

accidentally created more than one account. 

  

See Also: 

Accessing the Wimba Pronto Settings Page 

Modifying Your Course Settings 

Language Settings 
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Modifying Your Course Settings 

The Wimba Pronto Settings page allows you to individually enable or disable Wimba Pronto for each of your 

courses. This can be accomplished in the Course Settings area of the page. 

  

 

General  

Checking the box under the General heading allows you to select whether Wimba Pronto is automatically enabled 

for new courses in which you enroll. Keep in mind that this setting will remain in effect for future semesters. 

Course Participant 

The Course Participant section contains a list of all of the courses for which you can enable Wimba Pronto. Check 

the box next to a course name to enable Wimba Pronto or uncheck the box to disable it. 

  

Note: 
If Wimba Pronto  is disabled for a course, classmates will still be able to contact you. However, your name does 

not appear under the course name in their Classmates tab, and neither the course nor any classmates will appear 

in your Classmates tab. Effectively, it appears as if you are not enrolled in the course. 

Course Instructor (Displays for Instructors Only) 

This section is visible only if you are the instructor of a course. You have the option of enabling or disabling Wimba 

Pronto for an entire course. 

  

This setting will override the participant setting above. If a course is disabled, it will not appear in the participants' 

Classmates tab. However, Wimba Pronto  will still function, and participants will still be able to contact each other if 

they know each other's Pronto ID or have each other saved in their Contacts tab.
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Invitations 

Instructors can invite members of their courses who have yet to register for Wimba Pronto by following these steps: 

1. Click the Invite link next to the desired course. The invitations page appears. 

 
2. Click the box to the left of a user's name to include or exclude them from the invitation. You can click the 

All or None link below the Select Users box to select/deselect all users. 

3. You can type an optional custom message in the Your Message field, and then see how this message will 

appear in the email by clicking the Preview link. Your message will be incorporated into a template 

selected by your Wimba Pronto administrators. 

Note: 

The email address linked to your Pronto account will appear in the "from" field of the invitation. 

  

See Also: 
Accessing the Wimba Pronto Settings Page 

Modifying Your Account Settings 
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Inviting Others to Wimba Pronto 

If your institution has the invitation feature enabled, you can send email invites to fellow classmates to create a 

Wimba Pronto account. 

To Invite Users to Wimba Pronto 

1. In the Classmates tab, locate your classmate's name under any course. Classmates who do not currently 

have Pronto appear under the Without Pronto sub-heading. 

2. Double-click the user’s name. (Alternately, let the cursor hover over the name until an empty user profile 

appears, then click the Invite to Pronto link.) 

3. The Invite User to Wimba Pronto window opens. You can type an optional personalized message in the 

Your Message text field. 

 
4. Click Invite. 

Your classmate is sent an email from your address with a link to the Wimba Pronto registration page. 

Instructors 

Instructors can easily invite a course through one of the following methods:  

• Click the envelope icon  to the right of any Without Pronto sub-heading. 

• Click the gear icon  to the right of any course name and select Invite Course to Pronto. Only users who 

have yet to register for Wimba Pronto receive an invitation. 
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Text Chat 

About Text Chat 

Text Chat is the simplest form of communication in Wimba Pronto and, in many cases, it is also the most effective. 

Also known as instant messaging, Text Chat allows you to send a message, which is received immediately, to any 

user currently logged in to Wimba Pronto. The user can then reply to your message and you can have a 

conversation via a series of instant messages.  

  

Text Chat can also be used as a starting point for accessing Wimba Pronto's more advanced features. For example, 

before starting a Video  Call with someone, you may wish to send the user an instant message to make sure that 

they have a camera connected. 
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The Text Chat Window 

The Text Chat window is where instant messaging conversations take place. When you start a new Text Chat, this 

window opens, showing you all of the messages that have been sent and allowing you to type new messages. 

  

 

The Audio Call Button 

The Audio Call button allows you to start an Audio Call with the person with whom you are currently instant 

messaging. When you click the Audio Call button, the other user receives a notification of an incoming call, and can 

then accept or reject the call. It is possible to simultaneously use Audio Calling and Text Chat with the same user; if 

you start an Audio Call from the Text Chat window, your existing Text Chat remains open. 

The Video Call Button 

The Video Call button allows you to start a Video Call with the person with whom you are currently instant 

messaging. When click the Video Call button, the other user receives a notification of an incoming call, and can 

then accept or reject the call. It is possible to simultaneously use Video Calling and Text Chat with the same user; if 

you start a Video Call from the Text Chat window, your existing Text Chat remains open. 

The AppShare Button 

The AppShare button allows you to share a view of your desktop with the person with whom you are currently 

instant messaging. When you click the AppShare button, the other user receives an invitation to an AppShare 

session, which he or she can then accept or reject. It is possible to simultaneously use AppShare, Text Chat, and 

Audio or Video Calling with the same user; if you start an AppShare session from the Text Chat window, your 

existing Text Chat remains open. 
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The Whiteboard Button 

The Whiteboard button allows you to start a Whiteboard session with the person with whom you are currently 

instant messaging. When click the Whiteboard button, the other user receives an invitation to a Whiteboard 

session, which he or she can then accept or reject. It is possible to simultaneously use the Whiteboard and Text 

Chat with the same user; if you start a Whiteboard session from the Text Chat window, your existing Text Chat 

remains open. 

The Profile Drawer Button 

Clicking the Profile button reveals a drawer showing the user's profile information and current status. Clicking the 

button again hides the drawer. 

The Message Area 

The Message area displays all of the messages that have been sent between you and the other user. The user's 

name appears every time the sender of the message changes; the time that each message was sent is displayed 

along the right side of the window. You can use the scrollbars to see older messages not currently visible in the 

window.  

The Text Input Area 

The Text Input Area is where you type new messages. Messages are not visible to the other user until you press the 

Enter key on your keyboard to send them. Sent messages then appear in the Message Area. You can use the drop-

down menu on the right side of the area to add emoticons to your message. 

Chat Tabs 

Below the Text Input Area are the Chat tabs. These tabs show the name and status of the users with whom you are 

currently messaging. They also display the pencil icon  when the other user is typing. This indication can be 

useful for helping you to avoid typing at the same time as another user. If you have multiple text chats open, each 

session is represented by a separate tab; clicking a tab brings the conversation into focus. Tabbed chat is enabled 

by default, but can be disabled in the Preferences window.  

  

See Also: 
Starting a New Text Chat 

About Audio Calling 

About Video Calling 

About Application Sharing 

Emoticons 
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Starting a New Text Chat 

Before you can start a new Text Chat with someone, the user must first be in either your Contacts or Classmates tab. 

There are several ways to start a new Text Chat with a contact or classmate.  

To Start a New Text Chat 

1. Do one of the following: 

• Double-click the name of the user you wish to contact in either the Contacts or Classmates tab. 

• Click the name of the user you wish to contact and press the Enter key on your keyboard. 

• Click the name of the user you wish to contact and select Send Instant Message from the Actions 

menu. 

 

A new Text Chat window opens. 

 

 
 

 

2. Type your first message in the Text Input Area. 

3. Press the Enter key on your keyboard. The Text Chat session starts and your message is sent. 

  

See Also: 

The Text Chat Window 
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Emoticons 

Emoticons are special graphical icons that you can insert into any text-based chat to make your conversations more 

expressive and fun. The emoticons drop-down menu is located on the right side of the Text Input Area in all Text 

Chat windows.  

  

 
  

To insert an emoticon into your message, you can either click the image in the drop-down menu, or type its key 

combination (which is displayed in the lower left-hand corner of the drop down).  

  

Note: 

You can disable emoticon display in the Preferences window. 
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Audio Calling 

About Audio Calling 

Audio Calling can be used to make online communication more fluid and natural. Also known as Voice over IP 

(VoIP), Audio Calling allows you to have a real-time audio conversation with any user currently logged in to Wimba 

Pronto. Audio Calling differs from Text Chat in that you must call a user and wait for him or her to accept your 

invitation before your call can begin. You can also use Audio Calling in combination with other Wimba Pronto 

features such as Text Chat, Video Calling, Whiteboard, Application Sharing, Office Hours, and Group Chat. You can 

use Audio Calling with your computer's built-in microphone and standard headphones; but for best call quality, it is 

recommended that you have a USB headset with an integrated microphone. 
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The Audio Call Window 

The Audio Call window opens when you accept a new incoming call, or when a call you start is accepted by another 

user. The window contains all of the controls and settings for managing your Audio Calling session. 

  

 

The User Display Area 

The User Display Area shows the first name and profile picture of the user with whom you are speaking.  

The Call Status Bar 

The Call Status bar shows your network signal strength, the level of your outgoing audio signal, and the level of the 

incoming audio signal. 

The Talk/Lock Talk Button 

The Talk/Lock Talk button allows you to control your outgoing audio. To talk, either click and hold the Talk button, 

or press and hold either F8 or the Space Bar on your keyboard. If you would like to speak hands-free, either click 

the padlock section of the button, or press Ctrl+T (Windows) or Command+T (Mac) on your keyboard. 

  

Note: 
Unlike talking on a telephone, on an Audio Call the other user cannot automatically hear you speak. You must use 

the Talk/Lock Talk button or keyboard shortcuts to enable your outgoing audio. 
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The Options Menu 

The Options menu contains Audio Calling settings, as well as shortcuts for launching other Wimba Pronto features 

directly from your current call. 

 

• Lock Talk has the same effect as clicking the padlock section of the Talk/Lock Talk button; select this option 

to lock on your outgoing audio.  

• Hide Call Status allows you to toggle the display of the Call Status bar in the Audio Call window. 

• Preferences... opens the Preferences window to the Calls area, allowing you to manage your audio devices 

and system audio settings. 

• Chat opens a new Text Chat window between you and the user with whom you are currently speaking. 

• Video Call changes the current Audio Call into a Video Call. The other user must accept your Video Call 

invitation. 

• AppShare allows you to display a view your desktop to the user with whom you are currently speaking. 

The other user must accept your AppShare invitation before he or she can see your desktop.  

• End Call ends the current Audio Call.  

  

See Also: 
Starting a New Audio Call 

About Video Calling 

About Application Sharing 
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Starting a New Audio Call 

Before you can start a new Audio Call with someone, the user must first be in either your Contacts tab or your 

Classmates tab. Once someone is either a contact or a classmate, you can start an Audio Call through the Text Chat 

window.  

To Start a New Audio Call 

1. Do one of the following: 

• Double-click the name of the user you wish to call in either the Contacts or Classmates tab. 

• Select the name of the user you wish to contact and press the Enter key on your keyboard. 

 

The Text Chat window opens. 

 
2. Click the Audio Call button. A new Audio Call window opens, displaying the status Calling.  

  

When the user accepts the call, the Calling status is replaced by the Call Status bar, Options menu, and the 

Talk/Lock Talk button.  

  

See Also: 

The Audio Call Window 

The Text Chat Window 
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Video Calling 

About Video Calling 

Video Calling allows you to have a real-time, face-to-face conversation with any user currently logged in to Wimba 

Pronto. Like Audio Calling (and unlike Text Chat), a user must accept your call before the Video Calling session 

begins. Video Calling in Wimba Pronto is unique because both participants do not need have video capability in 

order to participate; using blended media, it is possible for one user to participate using video, while another user 

participates using only audio.  

  

You can also use Video Calling in combination with other Wimba Pronto features such as Text Chat, Audio Calling, 

Whiteboard, Application Sharing, Office Hours, and Group Chat. You must have a supported video device (such as a 

webcam) either built-in or connected to your computer to broadcast video during a Video Call. You can use your 

computer's built-in microphone and standard headphones; but for best audio quality, it is recommended that you 

have a USB headset with an integrated microphone. 
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The Video Call Window 

The Video Call window opens when you accept a new incoming Video Call, or when a call you start is accepted by 

another user. The window contains all of the controls and settings for managing your Video Calling session. 

  

  

 
  

The User Display Area shows the first name and video of the user with whom you are speaking, as well as your own 

video preview in the bottom right-hand corner. You can click and drag the video preview to move it to any of the 

four corners of the display area, as well as to resize it. During a 1-on-1 Video Call, you always see the other user’s 

video (if they are broadcasting), even while you are speaking. 

The Call Status Bar 

The Call Status bar shows your network signal strength, the level of your outgoing audio signal, and the level of the 

incoming audio signal. 

The Talk/Lock Talk Button 

The Talk/Lock Talk button allows you to control your outgoing audio. To talk, either click and hold the Talk button, 

press and hold F8 or the Space Bar on your keyboard. If you would like to speak hands-free, either click the padlock 

section of the button, or press Ctrl+T (Windows) or Command+T (Mac) on your keyboard. 

  

Note: 
Unlike talking on a telephone, on a Video Call the other user cannot automatically hear you speak. You must use 

the Talk/Lock Talk button or keyboard shortcuts to enable your outgoing audio. 
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The Broadcast Video Button 

The Broadcast Video button allows you to display your video. When the eye is closed , your video is not being 

transmitted and clicking the button broadcasts your video. When the eye is open , your video is being 

transmitted and clicking the icon ends your video broadcast. 

The Show/Hide Video Preview Button 

The Show/Hide Video Preview toggles the display of your own video preview in the User Display area. 

The Options Menu 

The Options menu contains Video Calling settings, as well as shortcuts for launching other Wimba Pronto features 

directly from your current call. 

 

• Broadcast Video/Stop Video Broadcast has the same function as the Broadcast Video button below the 

Call Status bar; select this option to either start or end the broadcast of your video to other participants. 

• Lock Talk has the same effect as clicking the padlock section of the Talk/Lock Talk button; select this option 

to lock on your outgoing audio.   

• Show Preview/Hide Preview has the same function as the Show/Hide Video Preview button below the 

Call Status bar; select this option to toggle the display of your own video preview in the User Display area. 

• Show Call Status/Hide Call Status allows you to toggle the display of the Call Status bar in the Video Call 

window. 

• Full Screen enlarges the Video Call window to display in your entire screen. Press F11 on your keyboard to 

exit full screen mode. 

• Hide Name Caption allows you to toggle the display of the other participant's first name in the User 

Display area. 

• Video Snapshot allows you to capture a still image from a Video call and either save it to your hard drive, 

or send it to an open Whiteboard session. 

• Preferences... opens the Preferences window to the Calls area, allowing you to manage your audio and 

video devices, as well as your system audio settings. 

• Chat opens a new Text Chat window between you and the user with whom you are currently speaking. 

• Audio Only changes your participation in the current call from video to audio-only. This selection applies 

only to you; the other user can still participate using video. You can switch back to video participation at 

any time by selecting Video Call from the Options menu. 

• AppShare allows you to display a view of your desktop to the user with whom you are currently speaking. 

The other user must accept your AppShare invitation before he or she can see your desktop.   

• End Call ends the current Video Call.  

 

See Also: 
Starting a New Video Call 

About Audio Calling 

About Application Sharing 
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Starting a New Video Call 

Before you can start a new Video Call with someone, the user must first be in either your Contacts or Classmates 

tab. Once someone is either a contact or a classmate, you can start a Video Call with the user through the Text Chat 

window. 

To Start a New Video Call 

1. Do one of the following: 

• Double-click the name of the user you wish to call in either the Classmates or the Contacts tab. 

• Select the name of the user you wish to contact and press the Enter key on your keyboard. 

 

The Text Chat window opens. 

 

 

 

2. Click the Video Call button. A new Video Call window opens, displaying the status Calling.  

  

When the user accepts the call, the Calling status is replaced by the user's video and the Call Status bar appears.  

  

See Also: 

The Video Call Window 
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Video Snapshot 

Video Snapshot allows you to capture a still image from a Video call and either save it to your hard drive, or send it 

to an open Whiteboard session. To capture an image, select Video Snapshot from the Options drop-down menu. 

You can also simply drag and drop the video from the Video Call window to the Whiteboard window. 

  

 
  

From the Video Capture window, you can select whether you wish to capture Broadcast video only, Preview video 

only, or both. Then click the Save button to save the image to your hard drive or the Send to Whiteboard button 

to send the image to a Whiteboard session. 

  

Note: 

The Send to Whiteboard button is only available if there is a Whiteboard session currently open. 

  

See Also: 

Whiteboard Video Snapshot 
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Application Sharing 

About Application Sharing 

Application Sharing allows you to share a live view of your desktop or any application on your computer with any 

other Wimba Pronto user. When you host an Application Sharing session, other users can see your screen just as if 

they were physically sitting at your computer. Because you can share virtually any application on your computer, 

the possibilities for collaboration are endless. You can choose exactly how much and which part of your screen you 

want to display. You can also give another user cursor and keyboard control of your desktop, allowing them to 

control and modify anything displayed on your screen. You can use Application Sharing in combination with 

Wimba Pronto's other features. For example, you could share your desktop while using Video Calling, all from 

within Office Hours.  
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The Application Sharing Control Window 

The Application Sharing Control window is used by the host of an Application Sharing session to manage what is 

displayed to other users in the Application Sharing Viewer window, as well as whether or not other users can 

control the shared content. The Application Sharing Control window is used in conjunction with the Application 

Sharing Screen Area Frame, which controls how much of your screen is displayed to other users. 
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The Application Sharing Screen Area Frame 

This resizable frame controls how much of your screen is displayed to other users; only the area contained within 

the box is shared. You can move the frame around by dragging any of the dashed edges and resize it by grabbing 

one of the eight control points located at the corners and on each side of the box. 

Cursor & Keyboard 

The Cursor & Keyboard drop down lets you grant cursor and keyboard control of the shared area to anyone 

currently in your Application Sharing session. The drop-down list contains the names of all of the current 

participants.  

AppShare Host 

The AppShare Host drop down lets you control which user's screen is being shared by choosing who is hosting the 

Application Sharing session. The drop-down list contains the names of all the current participants:  

The Options Menu 

The Options menu gives you access to shortcuts for launching other Wimba Pronto features from within an 

Application Sharing session, as well as for ending the current session.  

• Chat opens the Text Chat window with the participant(s) of the current Application Sharing session. 

• Call starts an Audio Call with the participant(s) of the current Application Sharing session. 

• Video starts a Video Call with the participant(s) of the current Application Sharing session. 

• End AppShare ends the current Application Sharing session. 

  

See Also: 
The Application Sharing Viewer Window 

Starting Application Sharing 

Changing Application Sharing Cursor and Keyboard Control 

Changing Application Sharing Host Control 
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The Application Sharing Viewer Window 

The Application Sharing Viewer window is the interface seen by participants of an Application Sharing session. The 

window contains the actual display of the host's screen, as well as an Options menu for managing the control of the 

session.  

  

 

The Application Sharing Display Area 

This area shows the screen that the host of the session is sharing. The view updates in real time and appears just as 

it would if you were sitting in front of the host's computer.  
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The Options Menu 

The Options menu gives you access to commands for managing the control of an Application Sharing session, as 

well as shortcuts for launching other Wimba Pronto features and ending the current session:  

• Request Cursor & Keyboard allows you to request control of the content being displayed by the host. 

• Request Presenter Control allows you to request to host the session and share your own screen. 

• Fit to Display adjusts the resolution of the shared content so that it fits in the current Application Sharing 

Display Area without scrollbars. This can be helpful if you have a smaller monitor or are using a laptop. 

• Chat opens the Text Chat window with the participant(s) of the current Application Sharing session. 

• Call starts an Audio Call with the participant(s) of the current Application Sharing session. 

• Video starts a Video Call with the participant(s) of the current Application Sharing session. 

• End AppShare ends the current Application Sharing session. 

  

See Also: 

The Application Sharing Control Window 

Starting Application Sharing 

Changing Application Sharing Cursor and Keyboard Control 

Changing Application Sharing Host Control 
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Starting Application Sharing 

Before you can start a new Application Sharing session with someone, the user must first be in either your Contacts 

or Classmates tab. Once someone is either a contact or a classmate, you can start an Application Sharing session 

with the user through the Text Chat window.   

To Start a New Application Sharing Session 

1. Do one of the following: 

• Double-click the name of the user you wish to call in either the Contacts or the Classmates tab. 

• Select the name of the user you wish to contact and press the Enter key on your keyboard. 

 

The Text Chat window opens. 

 

 
2. Click the AppShare button. The Application Sharing Host window opens, displaying the status Inviting.  

  

When the user accepts the invitation, the Inviting status is replaced by two drop-down menus in the Application 

Sharing Control window and the Application Sharing Screen Area Frame appears on your screen. 

  

See Also: 

The Application Sharing Control Window 
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Changing Application Sharing Cursor and Keyboard Control 

By default, Application Sharing displays a live view of the desired area to participants of the session, but only the 

host can control the content being displayed. The host can change this by granting  Cursor and Keyboard control to 

another user. When a user has Cursor and Keyboard privileges, he or she has full control of host's desktop, just as if 

they were physically sitting in front of the host's computer. This feature can be extremely useful for collaboration. 

  

There are two ways to change Cursor and Keyboard control: the host can grant control to another user, or another 

user can request control from the host. 

To Grant Cursor and Keyboard Control to Another User (as the Host) 

1. In the Application Sharing Control window, click the Cursor & Keyboard drop-down menu. 

2. Select the name of the user to whom you wish to grant cursor and keyboard control. The user receives 

cursor and keyboard control. 

  

The user is notified that they have received cursor and keyboard control by a pop-up message in the Application 

Sharing Viewer window. 

To Remove Cursor and Keyboard Control from Another User (as the Host)  

1. In the Application Sharing Control window, click the Cursor & Keyboard drop-down menu.  

2. Select your name. Cursor and keyboard control is removed for all users other than the host.  

  

Users are notified by a pop-up message that cursor and keyboard control has been removed. 

To Request Cursor and Keyboard Control from the Host 

1. In the Application Sharing Viewer window, click the Options menu. 

2. Select Request Cursor & Keyboard. The host is notified of your request. 

  

When the host grants you cursor and keyboard control, you are notified by a pop-up message in the Application 

Sharing Viewer window. 

  

Note: 
Because granting Cursor and Keyboard privileges gives a user full control of your computer, be sure to not leave 

an Application Sharing session unattended when someone else has control. 

See Also: 
Changing Application Sharing Host Control 

The Application Sharing Control Window 

The Application Sharing Viewer Window 



 
 
 

    
    
                                                                                                                                                                                                                                                                      61 
 

Changing Application Sharing Host Control 

You can change whose screen is being shared, without having to start a new session or re-invite users to 

participate.  

  

There are two ways to change Application Sharing Host Control: the host can request that another user share his or 

her screen, or another user can request host control. In both cases, the other user must accept the request to 

change the host of the session.  

To Request That Another User Take Host Control (as the Host) 

1. In the Application Sharing Control window, click the AppShare Host drop-down menu. 

2. Select the name of the user to whom you wish to grant host control. The user receives a request to host the 

session. 

  

When the user accepts your invitation to host the session, the Application Sharing Viewer window opens and a 

view of the user's display is shown. 

To Request Host Control from the Host  

1. In the Application Sharing Viewer window, click the Options menu. 

2. Select Request Presenter Control. The host is notified of your request. 

  

When the host grants control, the Application Sharing Host window opens. 

  

See Also: 
Changing Application Sharing Cursor and Keyboard Control 

The Application Sharing Control Window 

The Application Sharing Viewer Window 
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Whiteboard 

About Whiteboard 

The Wimba Pronto Whiteboard is a collaboration tool that allows two or more users to synchronously view and 

modify objects and text on shared canvases. Whiteboards are object-oriented, meaning that you can add and 

modify content independently of other objects on the canvas. This allows for virtually unlimited flexibility, control, 

and collaboration. You can use Whiteboards in conjunction with other Wimba Pronto features, such as Audio 

Calling, Video Calling, Group Chat, Office Hours, and Help Desks. 

  

Whiteboard features include: 

• Tool Color, Stylize, and Stroke Options 

• Multiple Canvases with Independent Navigation 

• Wimba Instructional Gallery content 

• Whiteboard Permissions Control 

• Content Import: .wwb, .ppt, .pptx, .png, .jpg, .bmp, .gif 

• Whiteboard Saving: .wwb, .pdf, .png, .jpg, .bmp 

• Video snapshot import from Video Calls 
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The Whiteboard Window 

The Whiteboard window is where all of the actions of a Whiteboard session take place. 

  

 

Actions Bar 

The Actions Bar contains buttons that allow you to save and import content, create new canvases, clear the current 

canvas, and undo the last action. 

Permissions Button 

The Permissions button provides access to the Whiteboard Permissions window. Permissions are only available 

when a Whiteboard session is initiated from a Group Chat, Office Hours, or a Help Desk. 

Actions Menu 

The Actions menu provides access to the same commands as the Actions Bar, as well as Object Action commands. 
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Canvas Area 

The Canvas area is where you can draw, add text, and add objects in your Whiteboard session. 

Canvas Navigation 

The Canvas Navigation controls allow you to navigate through multiple slides in your Whiteboard session. These 

controls may not be available to all users if the session host has limited navigation permissions. 

Tools 

The Whiteboard Tools allow you to draw, highlight, add text, and add shapes to a canvas. In addition, the Select 

tool allows you to select and modify objects already on your canvas; the Laser Pointer tool allows you to reference 

an area of a canvas without modifying it. 

Tool Color and Stylize 

The Tool Color and Stylize options allow you to change the appearance of the selected Whiteboard tool. 

Tool Options 

The Tool Options allow you to change the stroke and opacity of the selected Whiteboard tool, as well as the font, 

size, and style of Whiteboard text. 

Canvas Ribbon 

The Canvas Ribbon allows you to view and navigate through multiple canvases in a Whiteboard session. The 

Canvas Ribbon may be disabled if the session host has limited navigation permissions. 

Gallery Ribbon 

The Gallery Ribbon provides access to the Wimba Instructional Gallery, which contains useful graphics and 

backgrounds to add to your Whiteboard session. 
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Starting a Whiteboard Session 

Before you can start a new Whiteboard Session with someone, the user must first be in either your Contacts or 

Classmates tab. Once someone is either a contact or a classmate, you can start a Whiteboard session with the user 

through the Text Chat window. 

To Start a New Whiteboard Session 

1. Do one of the following: 

• Double-click the name of the user with whom you wish to start the Whiteboard session in either 

the Classmates or the Contacts tab. 

• Select the name of the user with whom you wish to start the Whiteboard session and press the 

Enter key on your keyboard. 

 

The Text Chat window opens. 

 

 
 

2. Click the Whiteboard button. A new Whiteboard window opens, first displaying the status Connecting to 

the Whiteboard and then Inviting <User Name> to a Whiteboard.  

  

When the user accepts the Whiteboard invitation, the Whiteboard session begins.  

  

Tips: 
a) You can also start a Whiteboard session from a Group Chat, Office Hours, or Help Desk. 

 

b) You can start a Whiteboard session without another participant by changing your status to Office Hours and 

then clicking the Whiteboard button in the Office Hours window. 
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Adding Objects to a Whiteboard 

Whiteboards are object-oriented, meaning that any content you add to a canvas remains independently 

modifiable, even after you add additional objects. There are a number of different types of content that you can 

add to canvases, and the process for doing so varies slightly by type.  

To Draw on or Highlight a Canvas 

1. Click the Pencil  or Highlighter  tool. 

2. Select the desired tool options. 

3. Draw on the canvas. 

To Add Text to a Canvas 

1. Click the Text tool . 

2. Select the desired tool options. 

3. Click on the canvas where you wish to add the text. 

4. Type the desired text. 

To Add Lines or Shapes to a Canvas 

1. Click the desired line or shape tool. 

2. Select the desired tool options. 

3. Click and hold on the canvas where you want the object to appear. 

4. Drag your cursor to set the size of the object. 

5. Release your cursor.  
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To Add Objects from the Wimba Instructional Gallery to a Canvas 

1. Click the Gallery ribbon. The Wimba Instructional Gallery opens. 

 

 

 

2. Select the desired object category. 

3. Select the desired object. 

4. Click on the canvas where you want the object to appear. 

Tip: 
If you wish to add the same Gallery object to a canvas more than once, click the object twice until the plus symbol 

(+) appears. You can then use the stamp tool and click on the canvas wherever you want to add the object. 

  

See Also: 
Modifying Objects on a Canvas 

Whiteboard Tools 

The Whiteboard Gallery Ribbon 
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Modifying Objects on a Whiteboard 

You can modify objects on a Whiteboard canvas at any time. There are several different ways to modify an object. 

To Move an Object 

1. Click the Select tool . 

2. Click the desired object on the canvas. 

3. Click and drag the center of the object to the desired location. 

4. Release your cursor. 

To Modify the Size, Shape, or Rotation of an Object 

1. Click the Select tool .  

2. Click the desired object on the canvas. 

3. Click and drag one of the handles to modify the size, shape, or rotation of the object. 

 
4. Release your cursor. 

To Modify the Appearance of an Object 

1. Click the Select tool . 

2. Click the desired object on the canvas. 

3. Make the desired changes to color, stylize, and tool options. 
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To Change the Arrangement of an Object 

1. Click the Select tool . 

2. Right-click (Windows) or Ctrl-click (Mac) the desired object on the canvas. The contextual menu appears. 

3. Select one of the following: 

• Send to Back to arrange the object behind all other objects on the canvas. 

• Bring to Front to arrange the object in front of all other objects on the canvas. 

To Change the Grouping of an Object 

1. Click the Select tool . 

2. Select more than one object on the canvas by either Shift-clicking and dragging your cursor around 

multiple objects to select them. 

3. Right-click (Windows) or Ctrl-click (Mac) one of the selected objects. 

4. Select one of the following: 

• Group to group all of the selected objects together so that they can be modified together. 

• Ungroup to ungroup the selected objects so that they can be modified independently. 

To Delete an Object 

1. Click the Select tool . 

2. Press the Delete key on your keyboard. 

  

Note: 

Any user with annotation permissions can modify and delete objects, not only the user that created them. 

  

See Also: 

Adding Objects to a Whiteboard 
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Importing Content to a Whiteboard 

You can import content from your computer to a Whiteboard session or import previously saved Wimba 

Whiteboard session archives. The supported import file types are: 

• .wwb (Wimba Whiteboard) 

• .ppt  

• .pptx  

• .png  

• .jpg  

• .bmp  

• .gif 

  

When you import .wwb, .ppt, or .pptx files, they are added to the Whiteboard as separate canvases. When you 

import .png, .jpg, .bmp, or .gif files, they are added to the current canvas as objects. 

To Import Content to a Whiteboard 

1. Click the Import button in the Actions bar. The Import file window opens. 

2. Select the desired content from your hard drive. 

3. Click the Open button. The content is imported to the Whiteboard. 

  

See Also: 

Saving Whiteboards 
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Saving Whiteboards 

You can save Whiteboard content for offline viewing or archiving purposes. Both single canvases and entire 

Whiteboards (containing all of the canvases in the session) can be saved in a variety of formats. If you save an entire 

Whiteboard in .wwb (Wimba Whiteboard archive) format, you can import it to another Whiteboard to continue the 

session at a later time. Single canvases and entire Whiteboards can be saved in the following formats: 

• .pdf 

• .png 

• .jpg 

• .bmp 

  

Entire Whiteboards can also be saved in .wwb format. 

To Save an Entire Whiteboard 

1. Click the Save button in the Actions bar. The Save to file window opens. 

2. Select the location on your hard drive where you wish to save the Whiteboard. 

3. Select the desired file type from the drop-down menu.  

4. Click the Save button. 

To Save a Single Whiteboard Canvas 

1. Navigate to the canvas you wish to save. 

2. Click the Save Canvas button in the Actions bar. The Save Canvas to file window opens. 

3. Select the location on your hard drive where you wish to save the canvas. 

4. Select the desired file type from the drop-down menu.  

5. Click the Save button. 

  

See Also: 

Importing Content to a Whiteboard 
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Whiteboard Action Tracking 

All users that have annotation permissions enabled can modify any object on a Whiteboard. If you want to find out 

which user created or last modified an object, right-click (Windows) or Ctrl-click (Mac) the object to show the 

contextual menu. The 'Created By' and 'Last Modified By' fields are located at the bottom of the menu. 

  

 
  

See Also: 
Whiteboard Permissions 

Modifying Objects on a Whiteboard 

Adding Objects to a Whiteboard 
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The Whiteboard Actions Bar 

The Whiteboard Actions bar contains buttons that allow you to save and import content, create new canvases, clear 

the current canvas, and undo the last action. 

  

 

Save 

Allows you to save the entire Whiteboard session in a variety of formats. 

Save Canvas 

Allows you to save the current Whiteboard canvas in a variety of formats. 

Import 

Allows you to import Power Point files, images, and saved Whiteboard archives into the Whiteboard session. 

New Canvas 

Adds a new canvas to the Whiteboard session. 

Clear Canvas 

Clears all objects from the current canvas. 

Undo 

Reverses the last action preformed on the current canvas. 

  

See Also: 

Saving Whiteboards 

Importing Content to a Whiteboard 
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Whiteboard Tools 

The Whiteboard Tools allow you to draw, highlight, add text, and add shapes to a canvas. In addition, the Select 

tool allows you to select and modify objects already on your canvas, and the Laser Pointer tool allows you to 

reference an area of a canvas without modifying it. 

  

 

Select 

The Select tool allows you to select and modify objects on a canvas. You can select more than one object at a time 

by holding down the shift key while clicking on multiple objects.   

Laser Pointer 

The Laser Pointer tool allows you to point out an area on a canvas to other participants in the Whiteboard session. 

When you click on a canvas with the Laser Pointer, a red dot appears in the same location on the canvases of the 

other Whiteboard participants. To change the position of the dot, click in another area of the canvas. The dot only 

appears where you click on the canvas; it does not continuously follow the movement of the laser pointer. 

Highlighter 

The Highlighter tool allows you to emphasize content on a canvas by drawing a semi-transparent line. This can be 

especially useful for text, but can be used to highlight any object on a canvas. Holding down the Shift key while 

drawing constrains the path of the Highlighter to 90-degree angles. 

Pencil 

The Pencil tool allows you to draw freeform objects on a canvas. Once you stop drawing with the Pencil, the line 

becomes an object that can be moved, scaled, and modified just like any other object in a Whiteboard, though the 

path of the line itself cannot be modified. Holding down the Shift key while drawing constrains the path of the 

Pencil to 90-degree angles. 
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Text 

The Text tool allows you to add text to a canvas. Once you stop typing with the Text tool, the text becomes an 

independent object that can be moved, scaled, and modified just like any other object in a Whiteboard, though the 

text itself cannot be changed. You can change the font, font size, and style of the text using the Whiteboard Tool 

Options. 

Line 

The Line tool allows you to draw straight lines on a canvas by clicking and holding to set the line's starting point, 

dragging your mouse and then releasing your mouse button to set the line's end point. Holding down the Shift key 

while drawing constrains the path of the Line tool to 45-degree angles. 

Filled Rectangle 

The Filled Rectangle tool allows you to draw filled rectangles on a canvas by clicking and holding to set the 

rectangle's origin, dragging your mouse and then releasing your mouse button to define its shape. Holding down 

the Shift key while dragging constrains the shape a square. 

Unfilled Rectangle 

The Unfilled Rectangle tool allows you to draw unfilled rectangles on a canvas by clicking and holding to set the 

rectangle's origin, dragging your mouse and then releasing your mouse button to define its shape. Holding down 

the Shift key while dragging constrains the shape a square. 

Filled Ellipse 

The Filled Ellipse tool allows you to draw filled ellipses on a canvas by clicking and holding to set the ellipse's origin, 

dragging your mouse and then releasing your mouse button to define its shape. Holding down the Shift key while 

dragging constrains the shape a circle. 

Unfilled Ellipse 

The Unfilled Ellipse tool allows you to draw unfilled ellipses on a canvas by clicking and holding to set the ellipse's 

origin, dragging your mouse and then releasing your mouse button to define its shape. Holding down the Shift key 

while dragging constrains the shape a circle. 

  

See Also: 
Adding Objects to a Whiteboard 

Modifying Objects on a Whiteboard 

Whiteboard Tool Color and Stylize 

Whiteboard Tool Options 
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Whiteboard Tool Color and Stylize 

The Tool Color and Stylize options allow you to change the appearance the selected Whiteboard Tool. 

  

 

Color 

You can change the color of objects created with the Highlighter, Pencil, Text, Line, Filled Rectangle, Unfilled 

Rectangle, Filled Ellipse, and Unfilled Ellipse tools. 

Stylize 

You can enable Stylize for the Pencil, Text, Line, Filled Rectangle, Unfilled Rectangle, Filled Ellipse, and Unfilled 

Ellipse tools by clicking the star button below the color selector. Stylize adds a drop-shadow effect to the Pencil, 

Text, Line, Unfilled Rectangle, and Unfilled Ellipse tools and a gradient fill effect to the Filled Rectangle and Filled 

Ellipse tools. Stylize is enabled by default. 

  

See Also: 
Adding Object to a Whiteboard 

Modifying Objects on a Whiteboard 

Whiteboard Tools 

Whiteboard Tool Options 
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Whiteboard Tool Options 

The Tool Options allow you to change the stroke and opacity of the selected Whiteboard tool, as well as the font, 

size, and style of Whiteboard text. 

  

 

Stroke 

Stroke allows you to modify the line thickness of objects created with the Highlighter, Pencil, Line, Unfilled 

Rectangle, and Unfilled Ellipse tools. 

Opacity 

Opacity allows you to modify the opacity of objects created with the Highlighter, Pencil, Text, Line, Filled Rectangle, 

Unfilled Rectangle, Filled Ellipse, and Unfilled Ellipse tools. 

Text Tool Options 

The Text Tool options allow you to modify the font, font size, and font style of selected text on a canvas. 

  

See Also: 

Adding Object to a Whiteboard 

Modifying Objects on a Whiteboard 

Whiteboard Tools 

Whiteboard Tool Color and Stylize 
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Whiteboard Permissions 

If a Whiteboard session is started from a Group Chat, Office Hours, or a Help Desk, the session's host can control the 

Whiteboard permissions for other participants. The session host is whoever initiates the Whiteboard session, not 

necessarily the host of the Office Hours or Help Desk, or the person who started the Group Chat. The Permissions 

button on the Actions bar is enabled for the session's host and provides access to the Whiteboard Permissions 

window. All Whiteboard permissions are enabled by default. 

  

 

Allow participants to annotate on the whiteboard 

Disabling this option prevents participants from using the Whiteboard tools (including the Select and Laser Pointer 

tools) as well as from importing images to the Whiteboard. 

Allow participants to navigate canvases 

Disabling this option prevents participants from accessing the Canvas ribbon or changing canvases using the 

navigation controls at the bottom of the Whiteboard window. If you disable this option, the option below it, 'Allow 

participants to import PowerPoint, create canvases, and save content,' is automatically disabled as well. 

Allow participants to import PowerPoint, create canvases, and save content 

Disabling this option prevents participants from importing PowerPoint files, creating new canvases, or saving 

Whiteboard content. Participants can still import .jpg, .png, .bmp, and .gif files. 

  

See Also: 
Whiteboard Canvas Navigation 

Importing Content to a Whiteboard 

Saving Whiteboards 
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The Whiteboard Gallery Ribbon 

The Whiteboard Gallery Ribbon provides access to the Wimba Instructional Gallery, which contains useful graphics 

and backgrounds to add to your Whiteboard session. 

  

 

Backgrounds 

You can select a new background for a canvas by clicking it in the Gallery ribbon. Backgrounds always remain 

behind all other objects on a canvas and cannot be modified. To clear the background of a canvas, click the Blank 

Canvas background.  

Gallery Objects 

The Gallery objects categories contain useful graphics that you can add to a canvas. You can move, scale, and rotate 

Gallery objects in the same way as objects created with the Whiteboard tools. The Gallery object categories are: 

• Common 

• Clip Art 

• Shapes 

• Flowchart 

• Math Operators 

• Math Relations 

• Logic 

• Greek Upper Case 

• Greek Lower Case 

• Statistics 

• Music 

• Astronomy 
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The Stamp Tool 

  

 
  

 If you wish to add the same Gallery object to a canvas more than once, click the object twice until the plus symbol 

(+) appears. You can then use the stamp tool and click on the canvas wherever you want to add the object. 

  

  

See Also: 
Adding Objects to a Whiteboard 

Modifying Objects on a Whiteboard 
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Whiteboard Canvas Navigation 

There are several different ways to navigate through Whiteboards that contain multiple canvases. In sessions in 

which all participants have canvas navigation privileges (enabled by default), anyone can change the canvas that is 

seen by all other participants, or navigate through canvases independently, without changing the view for other 

participants.  

  

  

 
  

  

There are two ways to navigate though Whiteboard canvases: using the navigation tools at the bottom of the 

Whiteboard window, or by selecting canvases directly from the Canvas ribbon. In both cases, the Explore button 

determines whether or not the navigation applies to all participants in the session, or only to a single participants. If 

you navigate through canvases with Explore disabled (which is the default setting), you affect the canvas view for 

all participants in the session; everyone sees the same canvas as you. If you enable Explore, you can navigate 

through canvases without affecting the view for other participants. This can be useful if you wish to preview a 

canvas before showing it to other participants.  

  

Note: 

The host of a Whiteboard session can disable canvas navigation for all participants in the Participant window. 

  

See Also: 

Whiteboard Permissions 
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Whiteboard Video Snapshot 

The Video Snapshot feature allows you to capture a still image from a Video Call. You can send an image to a 

Whiteboard session by simply dragging and dropping the video from a Video Call window to a Whiteboard 

window. Additionally, you can save a snapshot to a Whiteboard by clicking the Send to Whiteboard button in the 

Video Capture window. 

  

  

See Also: 

Video Snapshot 
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Group Chat 

About Group Chat 

Similar to an online chat room, Group Chat allows you to communicate with multiple users simultaneously. Group 

Chat starts in text-only mode, but you can access any of Wimba Pronto's other features – such as Audio Calling, 

Video Calling, Application Sharing, and Whiteboard – from a Group Chat session. For example, if you are in a text-

only Group Chat session, you can add Audio Calling to create group Audio Call, similar to a telephone conference 

call. You can also use blended audio and video to start a multimedia conference call. You can invite new 

participants to a Group Chat either while creating it, or after the session has already been created. Any participant, 

including the creator of the Group Chat, can leave a session at any time and the other participants are still able to 

continue the session. 
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The Group Chat Window 

The Group Chat window is similar to the Text Chat window, but with one major difference: the Group Chat window 

has a Participant List to the right of the Message Area that displays the names and statuses of all of the users 

currently in (or invited to) the Group Chat session. Like with the Text Chat window, you can use the Group Chat 

window as a jumping-off point for accessing other Wimba Pronto features, but in a group setting.  

  

  

 

The Audio Call Button 

The Audio Call button allows you to start an Audio Call with the participants of the current Group Chat. When you 

click the Audio Call button, all of the current Group Chat participants receive a notification, which they can then 

individually accept or reject. It is possible to simultaneously use Audio Calling and Text Chat; if you start an Audio 

Call from a Group Chat session, your existing Group Chat window remains open. All participants do not have to join 

the Audio Call invitation for it to function, but only those who do are able to hear the audio of the call.  
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The Video Call Button 

The Video Call button allows you to start a group video conference with the participants of the current Group Chat. 

When you click the Video Call button, all of the current Group Chat participants receive a notification, which they 

can then individually accept or reject. It is possible to simultaneously use Video Calling and Text Chat; if you start a 

Video Call from a Group Chat session, your existing Group Chat window remains open. All participants do not have 

to accept the Video Call invitation for it to function, but only those who do are able to view the call video. Users can 

also participate in the Video Call using audio-only.  

The AppShare Button 

The AppShare button allows you to share your desktop with the participants in the current Group Chat. When you 

click the AppShare button, all of the current Group Chat participants receive a notification for the AppShare session, 

which they can then individually accept or reject. If you start AppShare from a Group Chat session, the existing 

Group Chat window remains open. All participants do not need to accept the invitation for it to function. 

The Whiteboard Button 

The Whiteboard button allows you to start a Whiteboard session with the participants in the current Group Chat. 

When click the Whiteboard button, all of the current Group chat participants receive a notification for the 

Whiteboard session, which they can then individually accept or reject. If you start a Whiteboard session from a 

Group Chat session, the existing Group Chat window remains open. All participants do not need to accept the 

invitation for it to function. 

The Profile Drawer Button 

The Profile button shows the profile picture of the last user to type a message or speak (if you are using Audio or 

Video Calling). Selecting a user from the Participant List shows the user's profile picture for 15 seconds. Clicking the 

Profile button reveals a drawer showing the user's profile information and current status. Clicking the button again 

hides the drawer. 

The Message Area 

The Message Area displays all of the messages that have been sent between the participants of the Group Chat. The 

user's name appears every time the sender of the message changes; the time that each message was sent is 

displayed to the right of the message. You can use the scrollbars to see older messages (sent since you entered the 

Group Chat) not currently visible in the window.  

The Participant List 

The Participant List displays the names, Pronto IDs, and current statuses of all of the users in the Group Chat 

session. You can right-click (Ctrl-click on Mac) the name of a participant to access the user's profile, webpages, and 

email link. The pencil icon  is displayed next to the names of users that are currently typing a message. This 

indication can be useful for helping you to avoid typing at the same time as another user. The pending icon  

next to a user's name indicates that the user has received an invitation to join the session, but has not yet accepted 

it. An invitation can be canceled at any time before a user accepts it by hovering over the pending icon and clicking 

the x that appears. Only the person that invited a user can cancel his or her invitation. 
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The Text Input Area 

The Text Input Area is where you can type new messages. Messages are not visible to other users until you press 

the Enter key on your keyboard to send them. Sent messages then appear in the Message area. You can also use 

the drop-down menu on the right side of the area to add emoticons to your message. 

  

See Also: 
Starting a New Group Chat 

Inviting New Users to a Current Group Chat 

About Audio Calling 

About Video Calling 

About Application Sharing 

Emoticons 
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Starting a New Group Chat 

Before you can start a new Group Chat, the users that you wish to invite to the session must first be in either your 

Contacts or Classmates tab. Once the desired users are either contacts or classmates, there are several ways to start 

a new Group Chat. 

To Start a New Group Chat 

1. Select at least one of the users that you wish to invite in either the Contacts or Classmates tab. 

• You can invite multiple users at the same time (you can always invite additional participants later). 

  

To select multiple users, Ctrl-click (Windows) or Command-click (Mac) their names. 

2. Do one of the following: 

• Right-click (Ctrl-click on Mac) the name of one of the selected users and select Invite to Group 

Chat > New Group Chat. 

• Press Ctrl+G (Windows) or Command+G (Mac) on your keyboard. 

• Click on the View menu and select the option Invite to Group Chat > New Group Chat. 

  

Tips: 

a) You can invite an entire course or Contacts group by right-clicking on the course or group title, or by 

clicking the gear icon  

 

b) You can create an empty Invite to Group Chat window by selecting Invite to Group Chat > New 

Group Chat from the View menu with no users highlighted. 

The Invite to Group Chat window opens. 
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3. Type a name for the session in the Group Chat Name field. 

4. If you wish to invite additional participants, type their names in the Invite field. The names that you type are 

automatically completed based on the names in your Contacts and Classmates tabs. Alternatively, you can 

drag and drop additional users from your Contacts or Classmates tab into the Invite box.  

 

Press Enter on your keyboard to add the user to the Invited list.  

5. If you wish to remove a user from the Invited list, click the x icon  next to the user's name. 

6. Click Invite. The new session is created, a Group Chat window opens, and invitations are sent to all of the 

users in the Invited list.  

  

Tips: 
a) You can return to a Group Chat by selecting Recent Group Chats > from the Pronto menu (Windows) or the 

File menu (Mac). This can be especially useful if you leave a Group Chat unintentionally.  

 

b) You can start a new Group Chat based on a previously created session by selecting the name of the session 

(instead of New Group Chat) from the Invite to Group Chat > menu, or from the drop-down menu in the Invite 
to Group Chat window. This preserves only the name of the session and does not allow you to see previously 

sent messages. It also does not automatically invite the users from prior sessions. 

  

See Also: 
The Group Chat Window 

Inviting New Users to a Current Group Chat 
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Inviting New Users to a Current Group Chat 

At any time during a Group Chat, you can invite new users to join the session. You can invite a single user at a time 

or multiple users. Any current participant can invite new users, not just the creator of the session.  

To invite a new user, drag and drop the name of the user anywhere in the Group Chat window. The user's name 

appears with the pending icon  in the Participant List. This indicates that the user has received an invitation to 

join the session, but has not yet accepted it. 

  

Tip: 
An invitation can be canceled at any time before a user accepts it by hovering your cursor over the pending icon 

and clicking the x icon  that appears. Only the person that invited a user can cancel his or her invitation. 

  

See Also: 
The Group Chat Window 

Starting a New Group Chat 
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Office Hours 

About Office Hours 

Office Hours takes the concept of Group Chat one step further by creating a waiting room in which users line up to 

speak to the owner in the order that they enter the chat. It is especially useful for situations in which an instructor 

needs to communicate with multiple users in a structured setting.  

 

Unlike other types of chat in Wimba Pronto, Office Hours has multiple chat areas – the Main Room and the Waiting 

Room – and a new owner (or moderator) role to regulate the participation of the other users. When you start Office 

Hours, you automatically become the owner of the session. Your status is then displayed to other users as Office 

Hours and they can join your session. Depending on the settings defined when you create the session, you can 

either choose to have the first person in line automatically promoted to the Main Room, or choose to promote and 

demote participants manually. You can also access other Wimba Pronto features, such as Audio Calling, Video 

Calling, Whiteboard, and Application Sharing, directly from the Office Hours window.  
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The Office Hours Views 

Since there are different roles in Office Hours – host and participants – there are different windows for the different 

views that users see, depending on these roles and their current status. The three Office Hours windows are: the 

Office Hours Owner window, the Waiting Room window, and the Main Room Participant window. 

The Office Hours Owner Window 

  

 
  

This is the view that the host of an Office Hours session always sees. In addition to the Message Area, it contains lists 

of all of the participants both in the Main Room and in the Waiting Room. If Waiting Room chat is enabled, you can 

also choose to display those messages in this window. 
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The Waiting Room Window 

  

 
  

This is the view that participants see when they are in the Waiting Room when they have joined an Office Hours 

session, but have not yet been promoted to the Main Room. In this window, users may or may not be able to send 

messages to each other, depending on whether Waiting Room chat is enabled.  
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The Main Room Participant Window  

  

 
  

This is the view that participants see once they have been promoted to the Main Room. It is similar to the Office 

Hours Owner window, but does not contain options for promoting and demoting users and does not show the 

Waiting Room list or Waiting Room chat. This window is also similar to the Group Chat window. 

  

See Also: 
The Office Hours Owner Window 

The Waiting Room Window 

The Main Room Participant Window 

About Office Hours 
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The Office Hours Owner Window 

The Office Hours Owner window is the view that the owner of an Office Hours session always sees. In addition to 

the Message Area, it contains lists of all of the participants both in the Main Room and in the Waiting Room and 

controls for managing the promotion and demotion of users. 

  

 

The Audio Call Button 

The Audio Call button allows you to start an Audio Call with the participants currently in the Main Room. When you 

click the Audio Call button, all participants in the Main Room receive a notification, which they can then individually 

accept or reject. It is possible to simultaneously use Audio Calling and Text Chat; if you start an Audio Call from an 

Office Hours session, the Main Room window remains open. All participants do not have to accept the Audio Call 

invitation for it to function, but only those who do are able to hear the audio of the call. 

The Video Call Button 

The Video Call button allows you to start a group Video Call with participants currently in the Main Room. When 

you click the Video Call button, all participants in the Main Room receive a notification, which they can then 

individually accept or reject. It is possible to simultaneously use Video Calling and Text Chat; if you start a Video Call 

from an Office Hours session, the Main Room window remains open. All participants do not have to accept the 

Video Call invitation for it to function, but only those who do are able to view the call video. Users can also 

participate in the Video Call using audio-only.   

The AppShare Button 

The AppShare button allows you to share your desktop with the participants currently in the Main Room. When you 

click the AppShare button, all participants in the Main Room receive a notification for an AppShare session, which 
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they can then individually accept or reject. All of the participants do not need to accept the invitation for AppShare 

to function. 

The Whiteboard Button 

The Whiteboard button allows you to start a Whiteboard session with the participants currently in the Main Room. 

When you click the Whiteboard button, all participants in the Main Room receive a notification for the Whiteboard 

session, which they can then individually accept or reject. All participants do not need to accept the invitation for it 

to function. 

The Show Waiting Room Chat Button 

The Show Waiting Room Chat Button allows you to toggle the display of chat between the users in the Waiting 

Room. Clicking this button reveals the Waiting Room Chat Display below the Text Input area. 

The Profile Drawer Button 

The Profile button shows the profile picture of the last user in the Main Room to type a message or speak (if you are 

using Audio or Video Calling). Selecting a user from one of the Participant Lists shows the user's profile picture for 

15 seconds. Clicking the Profile button reveals a drawer showing the user's profile information and current status. 

Clicking the button again hides the drawer. 

The Message Area 

The Message Area displays all of the messages that have been sent between the participants in the Main Room. The 

user's name appears every time the sender of the message changes; the time that each message was sent is 

displayed to the right of the message. You can use the scrollbars to see older messages not currently visible in the 

window.  

The Main Room Participant List 

The Main Room Participant List displays the names, Pronto IDs, and statuses of all of the users currently in the Main 

Room. The list also shows whether a user is currently using Audio Calling, Video Calling, Application Sharing, or 

Whiteboard. You can right-click (Ctrl-click on Mac) the name of a participant to access the user's profile, webpages, 

and email link, or to remove the user from the Office Hours Session. The pencil icon  is displayed next to the 

names of users that are currently typing a message. This indication can be useful for helping you to avoid typing at 

the same time as another user.  

The Promote/Demote Button 

The Promote/Demote button is used for promoting users from the Waiting Room to the Main Room, or demoting 

users from the Main Room to the Waiting Room. By default, the button displays the text Promote. If you select a 

user in the Main Room Participant List, the button changes to Demote.  



 
 
 

    
    
                                                                                                                                                                                                                                                                      96 
 

The Waiting Room Participant List 

The Waiting Room Participant List displays the names, Pronto IDs, statuses, and time waiting of all users currently in 

the Waiting Room. The text below the user's name also displays his or her reason for entry. The pencil icon  is 

displayed next to the names of users that are currently typing a message. You can right-click (Ctrl-click on Mac) the 

name of a participant to access the user's profile, webpages, and email link, as well as to promote the user to the 

Main Room or remove the user from the Office Hours session. Above the Participant List is the Automatic 

Promotion check box, which allows you to enable or disable the automatic promotion to the Main Room of the first 

user in line when the Main Room is empty. 

The Send Button 

The Send button lets you send a message to all users in the Waiting Room. Users in the Main Room cannot see 

messages that you send to the Waiting Room. 

The Text Input Area 

The Text Input area is where you can type new messages to all users in the Main Room. Messages are not visible to 

other users until you press the Enter key on your keyboard to send them. Sent messages then appear in the 

Message Area. Users in the Waiting Room cannot see messages that you send to the Main Room. 

The Waiting Room Chat Display 

If you have enabled the Waiting Room Chat display, this area shows all of the messages sent between users in the 

Waiting Room. 

  

See Also: 
The Office Hours Views 

The Main Room Participant Window 

The Waiting Room Window 

About Office Hours 
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The Waiting Room Window 

The Waiting Room window is what users see when they have joined an Office Hours session, but have not yet been 

promoted to the Main Room. There are two different views for Waiting Room window, depending on whether or 

not it is anonymous.  

  

 
The image on the left shows a Waiting Room in which chat is allowed; the image on the right shows an anonymous 

Waiting Room in which chat is not allowed. 
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The Waiting Room Welcome Message 

This area displays the name of the Office Hours session and your current position in line. 

The Profile Drawer Button 

Unless the Waiting Room is anonymous, the Profile Drawer button shows the profile picture of the last user to type 

a message, or any user that is selected in the Participant List. Clicking this button reveals a drawer showing the 

user's profile information and current status. Clicking the button again hides the drawer. 

The Message Area 

If Waiting Room Chat is enabled, the Message Area displays all of the messages that have been sent between the 

participants of in the Waiting Room. The user's name appears every time the sender of the message changes; the 

time that each message was sent is displayed to the right of the message. You can use the scrollbars to see older 

messages (sent since you entered) not currently visible in the window. If Waiting Room Chat is disabled, the 

Message Area only displays a greeting and any other messages sent by the owner. 

The Waiting Room Participant List 

Unless the room is anonymous, the Waiting Room Participant List displays the names, Pronto IDs, statuses, and 

reasons for joining the session (if required) for all users currently in the Waiting Room. The list also shows your 

current place in line. You can right-click (Ctrl-click on Mac) the name of a participant to access the user's profile, 

webpages, and email link. The pencil icon  is displayed next to the names of users that are currently typing a 

message. If the Waiting Room is anonymous, the names of the other users waiting are displayed as Participant 

<#>. You can still see how many participants are currently waiting, as well as how long they have been waiting, but 

there is no way to know their identities or to communicate with them. 

The Text Input Area 

If Waiting Room chat is enabled, the Text Input area is where you can type new messages. Messages are not visible 

to other users until you press the Enter key on your keyboard to send them. Sent messages then appear in the 

Message Area. You can also use the drop-down menu on the right side of the Text Input area to add emoticons to 

your message. If Waiting Room chat is disabled, the Text Input area displays a message informing you that chat is 

not allowed in anonymous rooms. 

  

See Also: 

The Office Hours Views 

The Office Hours Owner Window 

The Main Room Participant Window 

About Office Hours 
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The Main Room Participant Window 

The Main Room Participant window is the view that participants see once they have been promoted to the Main 

Room. Although similar to the Office Hours Owner window, the Main Room Participant window does not contain 

options for promoting and demoting users, and does not show the Waiting Room list or chat. The Main Room 

Participant window is similar to the Group Chat window. 

  

 

The Audio Call Button 

The Audio Call button allows you to start an Audio Call with the participants currently in the Main Room. When you 

click the Audio Call button, all participants in the Main Room receive a notification, which they can then individually 

accept or reject. It is possible to simultaneously use Audio Calling and Text Chat; if you start an Audio Call from an 

Office Hours session, the Main Room window remains open. All participants do not have to accept the Audio Call 

invitation for it to function, but only those who do are able to hear the audio of the call. 

The Video Call Button 

The Video Call button allows you to start a group Video Call with participants currently in the Main Room. When 

you click the Video Call button, all participants in the Main Room receive a notification, which they can then 

individually accept or reject. It is possible to simultaneously use Video Calling and Text Chat; if you start a Video Call 

from an Office Hours session, the Main Room window remains open. All participants do not have to accept the 

Video Call invitation for it to function, but only those who do are able to view the call video. Users can also 

participate in the Video Call using audio-only.   



 
 
 

    
    
                                                                                                                                                                                                                                                                      100 
 

The AppShare Button 

The AppShare button allows you to share a view of your desktop with the participants currently in the Main Room. 

When you click the AppShare button, all participants in the Main Room receive a notification for the AppShare 

session, which they can then individually accept or reject. 

The Whiteboard Button 

The Whiteboard button allows you to start a Whiteboard session with participants currently in the Main Room. 

When click the Whiteboard button, all participants in the Main Room receive a notification for the Whiteboard 

session, which they can then individually accept or reject. 

The Profile Drawer Button 

The Profile button shows the profile picture of the last user in the Main Room to type a message or speak (if you are 

using Audio or Video Calling). Selecting a user from the Participant List shows the user's profile picture for 15 

seconds. Clicking the Profile button reveals a drawer showing the user's profile information and current status. 

Clicking the button again hides the drawer. 

The Message Area 

The Message Area displays all of the messages that have been sent between the participants of in the Main Room. 

The user's name appears every time the sender of the message changes; the time that each message was sent is 

displayed to the right of the message. You can use the scrollbars to see older messages (sent since you entered) not 

currently visible in the window.  

The Main Room Participant List 

The Main Room Participant List displays the names, Pronto IDs, and statuses of all of the users currently in the Main 

Room. The list also shows whether a user is currently using Audio Calling, Video Calling, Application Sharing, or 

Whiteboard. You can right-click (Ctrl-click on Mac) the name of a participant to access the user's profile, webpages, 

and email link. The pencil icon  is displayed next to the names of users that are currently typing a message. This 

indication can be useful for helping you to avoid typing at the same time as another user.  

The Text Input Area 

The Text Input area is where you can type new messages. Messages are not visible to other users until you press the 

Enter key on your keyboard to send them. Sent messages then appear in the Message Area. 

  

See Also: 

The Office Hours Views 

The Office Hours Owner Window 

The Waiting Room Window 

About Office Hours 
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Starting a New Default Office Hours Session 

The process for starting a new Office Hours session is different than for other types of chat in Wimba Pronto 

because you don't have to invite other users. Instead, you set your status to Office Hours and other users can 

contact you by joining your session. 

 To Start a New Default Office Hours Session 

1. Click the Status Bar. 

 

 
 

2. Select Office Hours. Your status changes to Office Hours and a new Office Hours window opens.  

Default Settings for Office Hours 

When you select Office Hours from the Status Bar, you are not asked to define settings for the session; instead, your 

session begins using the default settings. The default Office Hours settings are as follows: 

 

• Title: <User's First Name>'s Office Hours 

• Waiting Room Chat: Enabled 

• Automatic Promotion: Enabled 

• Allow Office Hours messaging only: Disabled 

• Require reason for entering: Enabled 

• Prompt for reason for entering: Please provide a topic for discussion. 

• Greeting for the waiting room: None 
  

See Also: 
Starting a New Custom Office Hours Session 

Joining an Office Hours Session 

About Office Hours 
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Starting a New Custom Office Hours Session 

Starting a custom Office Hours session is similar to starting a default Office Hours session, except that you are given 

the option to define custom settings for the session. 

To Start a New Custom Office Hours Session 

1. Click the Status Bar. 

2. Select Custom below Office Hours. The Edit Custom Status window opens. 

 

 
 

3. Select the desired settings for your Office Hours session: 

 

• Title allows you to set a custom name for the session (and your status). 

• Enable waiting room chatting allows you to set whether the Waiting Room is anonymous; if 

unchecked, Waiting Room participants cannot communicate or see each other's identities. 
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• Automatic promotion allows you to set whether or not the next user in line is automatically 

promoted when the Main Room is empty. 

• Allow Office Hours messaging only allows you to set whether or not users can send you instant 

messages outside of your Office Hours while you are hosting a session. 

• Require reason for entering allows you to set whether users entering the Office Hours session 

must give a reason for joining. You can also modify the message that prompts users to enter their 

reason. 

• Greeting for the waiting room allows you to create an optional greeting that is displayed to users 

upon entering the Waiting Room. 

• Save for future use allows you to save the current settings for the custom Office Hours session so 

that you can easily access it in the future. 

4. Click OK. Your status changes to the title you chose in Step 3 and a new Office Hours window opens. 

  

Note: 
If you check the Office Hours messaging only box, you cannot receive instant messages from other users while 

hosting an Office Hours session. When a user attempts to contact you, a notification is displayed saying that you 

are currently hosting Office Hours and may not have received the message. However, there is no way for other 

users to know whether or not you are accepting interruptions and, therefore, no way for them to know whether 

or not you received their message. 

See Also: 
Starting a New Default Office Hours Session 

Joining an Office Hours Session 

About Office Hours 
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Joining an Office Hours Session 

Anytime a user starts an Office Hours session, his or her status displays as Office Hours. You can join an Office 

Hours session similarly to how you would send the user an instant message, but instead of starting a new Text Chat, 

you enter the user's Office Hours session. 

To Join an Office Hours Session 

1. Do one of the following: 

• Double-click the name of the user whose Office Hours you wish to join. 

• Click the name of the user whose Office Hours you wish to join and press the Enter key on your 

keyboard. 

 

A new Text Chat window opens, displaying a notification that the user is currently holding Office Hours. 

 

 
 

2. Click the Join button. If the owner of the session has not requested that you provide a reason for joining, a 

new Office Hours window opens and you are added to the waiting room. 

 

If the owner of the session has requested that you provide a reason for joining, a new window opens, prompting 

you for this information: 
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3. Type your reason for joining in the box. 

 

 

 

4. Click OK. A new Office Hours window opens and you are added to the waiting room.  

  

Note:  
If the host of the Office Hours session has enabled automatic promotion, and you are the next person in line, you 

automatically join the Main Room. 

See Also: 
The Main Room Participant Window 

The Waiting Room Window 

About Office Hours 
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Promoting a Participant to the Main Room  

Promoting is the method used by the owner of an Office Hours session to move users from the Waiting Room to the 

Main Room. Although you can use Automatic Promotion to manage this process, you also have the option of 

manually promoting a user at any time. 

To Promote a Participant to the Main Room 

1. Click the name of the user that you wish to promote in the Waiting Room Participant List. 

 

 
 

2. Click the Promote button. The user is promoted to the Main Room. 

  

Tip: 
You can promote as many users as you wish to the Main Room. This can be useful if you see that multiple users in 

the waiting room wish to discuss the same topic.  

  

See Also: 

Demoting a Participant to the Waiting Room 

The Office Hours Owner Window 

About Office Hours 
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Demoting a Participant to the Waiting Room 

The owner of an Office Hours session has complete control over which users have access to the Main Room and can 

choose to demote a user to the Waiting Room at any time. This feature is especially useful if Automatic Promotion is 

enabled and a user was promoted earlier than the owner wished.  

To Demote a Participant to the Waiting Room 

1. Click the name of the user that you wish to demote in the Main Room Participant List. 

 

 
 

2. Click the Demote button. The user is demoted to the Waiting Room. 

  

Note: 
If you demote a participant to an empty Waiting Room, you must have Automatic Promotion disabled to prevent 

the user from automatically returning to the Main Room. You can also remove the user from the Office Hours 

session.  

See Also: 
Promoting a Participant to the Waiting Room 

The Office Hours Owner Window 

About Office Hours 
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Removing a Participant from an Office Hours Session 

In addition to promoting and demoting users, the owner of an Office Hours session can also remove a user from the 

session altogether. This feature can be useful if a user is idle as a result of having left his or her computer. You can 

remove users from both the Main Room and the Waiting Room.  

To Remove a Participant from an Office Hours Session 

1. Right-click (Ctrl-click on Mac) the name of the user in either the Main Room or Waiting Room Participant 

List. 

 

 
 

2. Select Remove <User Name>. The user is removed from the Office Hours session. 

  

Note: 

You do not need to give a reason for removing a participant from an Office Hours session. When removed, the 

user receives a message that says: You have been removed from <Title of Office Hours Session>.  

See Also: 
Promoting a Participant to the Main Room 

Demoting a Participant to the Waiting Room 

The Office Hours Owner Window 

About Office Hours 
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Viewing Waiting Room Chat 

If Waiting Room chat is enabled, participants waiting to enter the Main Room can send messages back and forth 

amongst themselves. The owner of the Office Hours session may wish to view the messages being sent in the 

Waiting Room, which can be done by enabling the Waiting Room Chat Display in the Office Hours Owner window.  

  

To toggle the display of the Waiting Room Chat Display, click the Show/Hide Waiting Room Chat button in the 

Office Hours Owner window. 

  

 
  

Note: 
Only the owner of a Office Hours session can view Waiting Room Chat; other participants in the Main Room never 

see messages being sent in the Waiting Room.  

See Also: 

The Office Hours Owner Window 

Broadcasting a Message to the Waiting Room 

About Office Hours 
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Sending a Message to the Waiting Room 

While the owner of an Office Hours session cannot enter the Waiting Room and participate directly in chat between 

participants, the owner can send messages to the Waiting Room. These messages are visible to all waiting users, 

but cannot be seen by Main Room participants. The owner can send a message to the Waiting Room even if 

Waiting Room chat is disabled. This feature is especially useful for telling waiting users that you will be ending the 

Office Hours session.  
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To Send a Message to the Waiting Room 

1. Click the Send... button below the Waiting Room Participant List in the Office Hours Owner window. The 

Message window opens. 

 

 

 

2. Type your message in the text box. 

3. Click Send. Your message is sent to the Waiting Room. 

  

See Also: 

Viewing Waiting Room Chat 
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Ending an Office Hours Session 

Unlike Group Chat, Office Hours is dependent on a single user (the owner) and cannot continue indefinitely if the 

owner leaves the session. This is just like when a professor ends office hours and leaves his or her office. When the 

owner leaves an Office Hours session, a five-minute countdown begins. During this time, any participants 

remaining in the Main Room or in the Waiting Room can continue to communicate and use features such as Audio 

Calling, Video Calling, and Application Sharing. Just as if the owner was present, however, users in the Main Room 

cannot communicate with users in the Waiting Room (and vice versa). Within five minutes of leaving the Office 

Hours session, the owner can return (by selecting the title of the chat from the Status Bar) and the Office Hours 

session continues. If the owner does not return within five minutes, the session ends, all users are removed from the 

Office Hours session and the window closes.  

To End an Office Hours Session 

Do one of the following: 

• Close the Office Hours Owner Window. 

• Change your status in the Status Bar to a non-Office Hours status. 

 

a. If there are participants in the Waiting Room, the Close Office Hours window opens and gives you the 

option to send a message to the Waiting Room. Do one of the following: 

 

• Type a message in the text box and click Send. 

• Click Don't Send to end the Office Hours session without sending a message. 

 

 

 

b. If there are no participants in the Waiting Room, a dialog appears asking you if you are sure that you want 

to close Office Hours. Click Close. 



 
 
 

    
    
                                                                                                                                                                                                                                                                      113 
 

Help Desks 

About Help Desks 

Help Desks are a special kind of Office Hours that can be set up by your institution to provide online access to 

offices and services. You can think of them as permanent Office Hours sessions managed by a particular 

department or office. Only users that are designated as its staff members can be owners of a particular Help Desk. 

While any Wimba Pronto user can be assigned as Help Desk staff (regardless of whether they are a student or an 

instructor), the Help Desks themselves can only be created and modified by a Wimba Pronto Administrator. If your 

institution has enabled Help Desks, they are listed under the School tab in the Wimba Pronto window. You can join 

and participate in a Help Desk session in the same way that you would for any other Office Hours.  

  

One key difference between Help Desks and Office Hours is that Help Desks can be staffed (or owned) by more than 

one user at a time. For example, if a school's library has three research assistants on duty at a time, all three of them 

can staff the same Help Desk simultaneously. When a Help Desk has more than one staff member, the session has 

one, shared list of waiting users, but a separate Main Room for each staff member. Promotion and demotion of 

participants between the Waiting Room and the Main Rooms is handled just like in Office Hours.  

  

For more information on creating, modifying, and managing Help Desks, refer to the Wimba Pronto Administrator 

Guide. 
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The School Tab 

The School tab is visible next to the Contacts and Classmates tabs in the Wimba Pronto window if your institution 

has activated at least one Help Desk. This tab shows all of the published Help Desks and their current status 

(available, offline, or full). Depending on your institution's setup, Help Desks may or may not be separated into 

categories. There is no way to move Help Desks between categories, or create new categories like groups in the 

Contacts tab.  

  

The Help Desk List 

The Help Desk List shows you all of the Help Desks that your institution has activated. You can join any open Help 

Desk from this list. Open Help Desks display the available icon  next to their names; closed Help Desks display 

the offline icon . You can also hover your cursor over the name of a Help Desk in the list to show a more detailed 

description. 

  

  

 

My Staff Positions 

If you have been designated as a staff member for a Help Desk by your institution's Wimba Pronto Administrator, 

the Help Desk is listed in the My Staff Positions section of the School tab. You can assume the staff role for any Help 

Desk from this list. Like with the main Help Desk List, the My Staff Positions section shows the status of all listed 

Help Desks. Help Desks that are already staffed by another user display the available icon  ; Help Desks that are 

not currently staffed, and are therefore closed, display the offline icon . 

  

See Also: 
Joining a Help Desk 

Assuming the Staff Role for a Help Desk 

About Office Hours 
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Joining a Help Desk 

Joining a Help Desk is just like joining Office Hours, except that you can only access Help Desks from the School tab. 

You can join any Help Desk that is currently open. Open Help Desks display the available icon ; closed Help 

Desks display the offline icon . 

To Join a Help Desk 

1. Do one of the following: 

• Double-click the name of the Help Desk you wish to join. 

• Click the name of the Help Desk you wish to join and press the Enter key on your keyboard. 

 

If the Help Desk does not require that you provide a reason for entering, a new Help Desk window opens and 

you are added to the Waiting Room. 

  

If the Help Desk requires that you provide a reason for entering, a new window opens, prompting you for this 

information. 
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2. Type your reason for joining the Help Desk in the text box. 

3. Click OK. A new Help Desk window opens and you are added to the Waiting Room. 

  

Note: 
If the Help Desk has automatic promotion enabled and you are the next person in line, you will be automatically 

promoted to the Main Room as soon as you enter the Waiting Room. If there are other users ahead of you, or if 

automatic promotion is disabled, you first enter the Waiting Room. 

Tip: 
If a Help Desk is hosted by more than one staff member, you cannot choose to which staff member's room you 

are promoted. However, since staff members can see the reason you give for joining a Help Desk, the more 

detailed you make your description, the more likely it is that you will be promoted by the staff member that can 

best assist you. 

  

See Also: 
Assuming the Staff Role for a Help Desk 

The School Tab 
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Assuming the Staff Role for a Help Desk 

Only users that have been designated as staff members for a Help Desk can assume the staff role and serve as a 

session's host. The Help Desks for which you are a staff member are listed in the My Staff Positions section of the 

School tab.  

To Assume the Staff Role for a Help Desk 

1. Double-click the name of the Help Desk that you wish to staff in the My Staff Positions list. The Help Desk 

Staff window opens. 

 

 
 

2. Select how you wish to be identified; you can either be identified by your real name or as an anonymous 

representative (in which case your name appears as Representative # _).  

3. Click OK. You assume the staff role for the Help Desk and a new Help Desk window opens. 

  

Note: 
Unlike with Office Hours, when you are staff of a Help Desk, your status does not change; other users do not know 

that you are staffing a Help Desk and can still contact you privately.  

Tip: 

It is possible to assume the staff role for multiple Help Desks simultaneously. 

  

See Also: 
Joining a Help Desk 

The School Tab 
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Creating and Managing Help Desks 

Creating, modifying, and managing Help Desks is performed from the Wimba Pronto Administration interface and 

is only accessible to an institution's Wimba Pronto Administrator. 

  

For more information, refer to the Wimba Pronto Administrator Guide. 
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Preferences 

Accessing the Preferences Window 

The Preferences window gives you access to wide range of options and settings for using Wimba Pronto.  

To Access the Preferences Window 

1. Click the Pronto menu. 

2. Select Preferences... The Preferences window opens. 

  

 
  

The Preferences window is separated into different sections: General, Appearance, Status, Alerts, Calls, Privacy, and 

Profile. 
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General Preferences 

 

Sign In 

• Start Pronto when my computer starts automatically launches Wimba Pronto every time you turn on 

your computer.  

• Sign me in when Pronto starts automatically signs you on to Wimba Pronto using the current Wimba 

Pronto account every time you launch the program. 
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Messages 

• Use tabbed chats opens new text chats as tabs within one window, rather than separate windows. 

• New message window is always blank opens new Text Chat windows without showing previous 

messages sent between you and the other user. 

• Enter key sends messages (Shift-Enter for line break) allows you to use the Enter key on your keyboard 

to send messages in Text Chat. 

• Warn me before closing a chat with multiple participants displays a warning dialog when you try to 

close a chat window with more than one participant. 

• Give keyboard focus to new messages brings incoming messages to the front or, if tabs are enabled, 

automatically displays the tab of the new messages. 

• Disable emoticons disables the display of emoticon images. 

Updates 

• Automatically check for Pronto updates allows you to set whether Wimba Pronto automatically checks 

for new software updates. If selected, the When Pronto updates are found: options can be modified. 

o Ask me what I want to do prompts you before downloading an update. 

o Automatically download the update downloads updates without notifying you. 

Chat Logs 

• Save chat logs allows you to set whether or not chat logs of all of your Text Chat conversations are 

automatically saved on your hard drive. 

Language 

The Language drop-down menu allows you to set the language for the Wimba Pronto interface. By default this is 

set to match the language setting for your computer's operating system (if possible). 
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Appearance Preferences 

 

Messages  

The Messages area displays of preview of the current appearance settings for the Text Chat window; any changes 

you make in the sections below are reflected in this preview. 

Header 

You can change the text color for your name and the names of other users in the text chat window by clicking the 

respective color boxes. You can change the font for the names by clicking the Choose Font... button. 
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Message Body 

You can change the color of the message text in the text chat window by clicking the color box labeled text. You 

can change the background color of the text chat window by clicking the color box labeled bg. You can change the 

font for the message text by clicking the Choose Font... button.  

Contact List 

You can change the font that is used to display the names of users, groups, courses, and Help Desks by clicking the 

Choose Font... button in the Contact List area. 

Reset Appearance Defaults 

If you want to undo all changes you have made and return to the original appearance defaults, click the Reset 

Appearance Defaults button. 
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Status Preferences 

The Status section allows you to add, delete, and modify your custom status messages. Statuses that you have 

already created are shown in the list.  

  

 
  

You can add a new status by clicking the plus button  or remove a selected status by clicking the minus button 

. Select a status and click Edit to modify it. The Auto-Idle check box allows you to set a time after which your 

status is automatically set to idle.  
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Alerts Preferences 

The Alerts section allows you to set a custom alert profile for a number of different actions in Wimba Pronto.  

  

 
  

• When this happens: lists all of the actions for which you can set alerts.  

• Once you select an action from the list, you can set which type of alert you want to associate with it in the 

Do this: area.  

• The Use alerts for my contacts only checkbox is a global setting that allows you to apply the alerts that 

you have defined only to people in your Contacts tab.  

• Alert sound output: allows you to choose the sound device used for playing alert sounds. 
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Calls Preferences 

 
  

• Audio Input allows you to select the device that Wimba Pronto uses for incoming audio. 

• Audio Output allows you to select the device that Wimba Pronto uses for outgoing audio. 

• Auto Gain Control can help normalize the volume of incoming and outgoing audio by automatically 

boosting low-level audio and lowering high-level audio.  

• Microphone Boost raises the level of your audio input if your microphone level is too weak.   

• Noise Reduction can help reduce the level of background noise picked up by your microphone.  

• Silence Detection allows you to transmit audio only when you are speaking, preventing static or 

background noise.  

• Video Device allows you to select the device that Wimba Pronto uses for video input. 

• Video Connection allows you to adjust the video quality in Wimba Pronto to match your connection 

speed. 

• Automatically select new devices when inserted allows you to set whether or not Wimba Pronto 

automatically uses audio and video devices that are connected while the program is running. 
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Privacy Preferences 

 
  

• Block List displays users that you have blocked from contacting you. 

• The plus button  allows you to add new users to your Block List. 

• The minus button  allows you to remove selected users from your Block List. 

• Sign in as invisible automatically sets your status to invisible when you log in to your Wimba Pronto 

account. 

• Don't show when I am typing disables the pencil icon  that informs other users that you are typing. 

• Make me invisible to anyone not in my classes or contacts always displays your status as invisible to any 

user not in your Contacts or Classmates tab.  
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Profile Preferences 

 

Profile Picture  

You can add a picture that is visible to other Wimba Pronto users to add a personal touch to your profile. Your 

picture is visible any time you contact another Wimba Pronto user, anytime another user contacts you, when a user 

views your profile, or when a user hovers his or her cursor over your name in the Contacts or Classmates tab. To add 

a profile picture, either drag and drop an image file from your hard drive to the Drag Image Here box, or click the 

Choose Picture... button and browse your hard drive for the desired picture. The profile picture box is optimized 

for square images, but accepts images of any proportions.  
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Email 

You can add an email address to make it easier for other users to contact you even if you are not online. This 

address does not need to be your school email address, or the address associated with your Wimba Pronto account. 

About Me 

The About Me box allows you to enter a brief description to introduce yourself to other users. This could include 

your interests, your major, where you're from, or the type of people with whom you would like to communicate 

using Wimba Pronto.  

My Webpages 

The My Webpages box allows you to include links in your profile to the webpages of your choice. 
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Message Logs 

Saving a Single Chat 

While it is possible to enable Wimba Pronto to automatically save message logs of all of your Text Chats, you can 

also save a single chat as an .html file. This feature can be useful if there is information in a chat session that you 

want to be able to refer to later, but you don't want to have to search through all of your message logs to find it. 

You can save a single chat from any form of text-based chat, including Text Chat, Group Chat, Office Hours, and 

Help Desks. 

To Save a Single Chat 

1. Click the File menu in the window of the chat that you wish to save. 

2. Select Save As... The Save Chat Log window opens. 

3. Choose the location where you wish to save the log. 

4. Type a name for the log in the File name box. 

5. Click Save. 

  

See Also: 

Viewing Message Logs 

Enabling Automatic Message Log Saving 
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Enabling Automatic Message Log Saving 

By default, automatic message log saving is disabled in Wimba Pronto. If you wish to automatically store messages 

logs of all of your Text Chats, you can enable this feature in the Preferences window.  

To Enable Automatic Message Log Saving 

1. Click the Pronto menu. 

2. Select Preferences... The Preferences window opens. 

3. Select General (if it is not already selected).  

 

 
 

4. Check the Save chat logs box. 

5. Click OK. 

  

Note: 
If you upgraded to Wimba Pronto from an earlier version, message log saving may already be enabled by default. 

Uncheck the Save chat logs box to disable it. 

See Also: 
Viewing Message Logs 

Saving a Single Chat 
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Viewing Message Logs 

You can set Wimba Pronto to automatically store messages logs of all of your text chats. If enabled, logs are saved 

to your hard drive as plain text files that contain the text, time, and date sent for each message. Messages logs are 

never stored on the Wimba Pronto server. There are two ways to access message logs: you can either browse 

through all of the available logs, or you can view the message log between you and a particular user. 

To View the Message Log Between You and a Particular User 

1. Click the name of the desired user in either the Contacts or the Classmates tab. 

2. Click the Actions menu. 

3. Select Show Message Log. The message log opens. 

To View Browse All Message Logs 

1. Click the Actions menu. 

2. Select Browse Message Logs. The directory containing all of your message logs opens. 

  

See Also: 

Enabling Automatic Message Log Saving 

Saving a Single Chat 



 
 
 

    
    
                                                                                                                                                                                                                                                                      133 
 

Broadcast Notifications 

Broadcast Notifications let administrators send institution-wide notifications to all of their Wimba Pronto users. 

Notifications can only be sent by an institution's Wimba Pronto Administrator; neither students nor instructors can 

create or modify notifications. When an institution sends a notification, it is visible to all of its Wimba Pronto users 

for the amount of time specified when it was created. If you are either online when the notification is sent, or you 

log in to your account during the time in which it is active, the notification appears as a pop-up message. The 

notification stays visible until you acknowledge it.  

  

Broadcast Notifications display the name of the sender, the message text, the time sent and, optionally, a link for 

more information. 

  

 
  

For further details on creating and sending Broadcast Notifications, refer to the Wimba Pronto Administrator Guide. 



 
 
 

    
    
                                                                                                                                                                                                                                                                      134 
 

Language Settings 

Wimba Pronto is available in both English and Spanish. The client contains both languages; there is no need to 

download additional language packs. You can change your personal language preference at any time. If you do not 

set a language preference, Wimba Pronto uses the language preference from your computer's operating system (if 

possible). If your computer's operating system is set to a language other than English or Spanish, Wimba Pronto 

defaults to English.  

  

The Wimba Pronto Settings page is also available in English and Spanish. The default language for the page is set 

by your institution's Wimba Pronto Administrator and can be modified individually by each user.  

To Change the Language Setting for the Wimba Pronto Client 

1. Click the Pronto menu. 

2. Select Preferences... The Preferences window opens. 

3. Select General (if it is not already selected). 

4. Select the desired language from the Language drop-down menu. 

 

 
 

5. Click OK. Your language preference for the Wimba Pronto client is set.  

  

Note: 
The language setting that you select in the Preferences window is maintained even if you log out and log back in 

to the Wimba Pronto client. 

To Change the Language Setting for the Wimba Pronto Settings Page 

1. Access the Wimba Pronto Settings page. 

2. Click the Language drop-down menu. 

3. Select the desired language. Your language setting for the Wimba Pronto Settings page is set. 

  

Note: 

Changing the language setting for the Wimba Pronto Settings page does not affect the language display setting 

for the Wimba Pronto client. 

  

See Also: 
General Preferences 

Accessing the Wimba Pronto Settings Page 

Modifying Your Account Settings 
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Keyboard Shortcuts 

The following keyboard shortcuts can make it easier to access certain features in Wimba Pronto: 

  

General Keyboard Shortcuts 

• Start a New Group Chat : Ctrl+G (Windows), Command+G (Mac) 

• Access the Preferences window: Ctrl+, (Windows), Command+, (Mac) 

• Add a Group to the Contacts tab: Ctrl+Shift+G (Windows), Command+Shift+G (Mac) 

• Add a Selected Classmate to the Contacts tab: Ctrl+Shift+A (Windows), Command+Shift+A (Mac) 

• Start an Audio Call with the Selected User: Ctrl+K (Windows), Command+K (Mac) 

• Start a Video Call with the Selected User: Ctrl+Shift+V (Windows), Command+Shift+V (Mac) 

• Start an Application Sharing Session with the Selected User: Ctrl+Shift+S (Windows), Command+Shift+S 

(Mac) 

  

During an Audio or Video Call 

• Talk: F8 or Space Bar (F8 works when any part of the Wimba Pronto application has focus; Space Bar 

works only when the Audio Call window has focus) 
• Toggle Lock Talk: Ctrl+T (Windows), Command+T (Mac) (Works when any part of the Wimba Pronto 

application has focus.) 

• Toggle Full-Screen Video: F11 

• End Call: Ctrl+F4 (Windows), Command+F4 (Mac) 

  

During an Application Sharing Session 

• Request Keyboard and Cursor Control: Ctrl+R (Windows), Command+R (Mac) 
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Software Updates 

From time to time, Wimba releases new software updates for Wimba Pronto. By default, the program automatically 

checks for updates periodically and, when an update is found, asks you whether or not you want to download it. 

You can change these settings in the Preferences window. You can also manually check for updates at any time. 

To Change Your Software Update Settings 

1. Click the Pronto menu. 

2. Select Preferences... The Preferences window opens. 

3. Select General (if it is not already selected). 

 

 
 

4. In the Updates area, adjust the settings as desired: 

• Automatically check for Pronto updates allows you to enable or disable automatic update 

detection. If selected, the When Pronto updates are found: options can be modified: 

o Ask me what I want to do asks you whether or not you want to download updates when they 

are detected. 

o Automatically download the update downloads updates when they are detected without 

asking you first. 

5. Click OK. 

To Manually Check for Software Updates 

1. Click the Help menu in the Wimba Pronto window. 

2. Select Check For Updates... A dialog box appears, telling you whether or not new updates are available. 
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Additional Resources 

To access all of Wimba's support resources, visit:   

http://www.wimba.com/services/support 

Technical Support 

If you experience technical difficulties while using Wimba Pronto, please contact Wimba at:  

technicalsupport@wimba.com 

Additional Documentation 

For more information on Wimba Pronto's more advanced features see the following guides: 

Wimba Pronto Administrator Guide 

Wimba Pronto Computer Lab Installation Guide 

Wimba Pronto Help Desk Guide 

Community 

We encourage Wimba users of all levels to join our Wimba Connect User Group, a new community in which users 

can share their experiences, ideas, research, and best practices with their peers via forums and user-generated 

blogs. In addition to bringing our users closer together, the group acts as a 365-day-a-year extension of our annual 

Wimba Connect Global Users Conferences.  

  

For more information, or to register for the Wimba Connect User Group, visit http://www.wimba.com/community. 

http://www.wimba.com/services/support�
mailto:technicalsupport@wimba.com�
http://www.wimba.com/community�
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Product Feedback 

Wimba welcomes your comments and suggestions. If you have an idea for a new feature or enhancement, or would 

like to send other feedback, please click the link below:  

Wimba Product Feedback Form 

  

You may also email your suggestions to feedback@wimba.com  

  

Your suggestion will be sent directly to Wimba's Product Management Team. 

http://www.wimba.com/company/contact?form=product_feedback�
mailto:feedback@wimba.com�
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Disclaimer 
This Guide, as well as the software described in it, furnished under license may only be used or copied in 

accordance with the terms of such license. The information in this Guide is furnished for information purposes only, 

is subject to change without notice, and should not be construed as a commitment by Wimba, Inc. Wimba, Inc. 

assumes no responsibility or liability for any errors or inaccuracies that may appear in this Guide. Except as 

permitted by such license, no part of this Guide publication may be reproduced, stored in a retrieval system or 

transmitted in any form by any means, electronic, mechanical, recording or otherwise without the prior written 

permission of Wimba, Inc. Any references to company names in examples or illustrations are for demonstration 

purposes only and are not intended to refer to any actual organizations.  

  

Wimba Pronto and the Wimba logos and trademarks are property of Wimba, Inc., 10 East 40th St, Floor 11, New 

York, NY 10016.  
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